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Notice
Every effort was made to ensure that the information in this document 
was complete and accurate at the time of printing. However, information 
is subject to change.

Preventing Toll Fraud
�Toll fraud� is the unauthorized use of your telecommunications system 
by an unauthorized party (for example, a person who is not a corporate 
employee, agent, subcontractor, or working on your company's behalf). 
Be aware that there may be a risk of toll fraud associated with your 
system and that, if toll fraud occurs, it can result in substantial additional 
charges for your telecommunications services.

Avaya Fraud Intervention
If you suspect that you are being victimized by toll fraud and you need 
technical assistance or support, call Technical Service Center Toll Fraud 
Intervention Hotline at +1 800 643 2353 for the United States and 
Canada. For additional support telephone numbers, see the Avaya Web 
site:
http://www.avaya.com 
Select Support, then select Escalation Lists US and International. 
This Web site includes telephone numbers for escalation within the 
United States. For escalation telephone numbers outside the United 
States, select Global Escalation List.

Providing Telecommunications Security
Telecommunications security (of voice, data, and/or video 
communications) is the prevention of any type of intrusion to (that is, 
either unauthorized or malicious access to or use of) your company's 
telecommunications equipment by some party.
Your company's �telecommunications equipment� includes both this 
Avaya product and any other voice/data/video equipment that could be 
accessed via this Avaya product (that is, �networked equipment�).
An �outside party� is anyone who is not a corporate employee, agent, 
subcontractor, or working on your company's behalf. Whereas, a 
�malicious party� is anyone (including someone who may be otherwise 
authorized) who accesses your telecommunications equipment with 
either malicious or mischievous intent.
Such intrusions may be either to/through synchronous (time-multiplexed 
and/or circuit-based) or asynchronous (character-, message-, or packet-
based) equipment or interfaces for reasons of:

� Utilization (of capabilities special to the accessed equipment)
� Theft (such as, of intellectual property, financial assets, or 

toll-facility access)
� Eavesdropping (privacy invasions to humans)
� Mischief (troubling, but apparently innocuous, tampering)
� Harm (such as harmful tampering, data loss or alteration, 

regardless of motive or intent)
Be aware that there may be a risk of unauthorized intrusions associated 
with your system and/or its networked equipment. Also realize that, if 
such an intrusion should occur, it could result in a variety of losses to your 
company (including but not limited to, human/data privacy, intellectual 
property, material assets, financial resources, labor costs, and/or legal 
costs).

Your Responsibility for Your Company's Telecommunications 
Security
The final responsibility for securing both this system and its networked 
equipment rests with you - an Avaya customer's system administrator, 
your telecommunications peers, and your managers. Base the fulfillment 
of your responsibility on acquired knowledge and resources from a 
variety of sources including but not limited to:

� Installation documents
� System administration documents
� Security documents
� Hardware-/software-based security tools
� Shared information between you and your peers
� Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and 
your peers should carefully program and configure:

� your Avaya-provided telecommunications systems and their 
interfaces

� your Avaya-provided software applications, as well as their 
underlying hardware/software platforms and interfaces

� any other equipment networked to your Avaya products.

Trademarks
Avaya is a trademark of Avaya, Inc.

Ordering Information
Call: Avaya Publications Center

Voice +1 800 457 1235
Fax +1 800 457 1764
International Voice +1 410 568 3680
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Avaya Support
Avaya provides a telephone number for you to use to report problems or 
to ask questions about your contact center. The support telephone 
number is 1-800-242-2121 in the United States. For additional support 
telephone numbers, see the Avaya Web site:
http://www.avaya.com 
Select Support, then select Escalation Lists US and International. 
This Web site includes telephone numbers for escalation within the 
United States. For escalation telephone numbers outside the United 
States, select Global Escalation List.

Avaya Training
Avaya provides training for Avaya Operational Analyst. For more 
information, contact Avaya University at:

Web site: http://www.avaya-learning.com/logon_form.asp 
E-mail address: avaya.u.helpdesk@accenture.com 
US telephone: 800-288-5327
Outside US telephone: +001 303-406-6089
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Introduction

Avaya Operational Analyst allows businesses to perform operational reporting for a 
multimedia contact center, smoothly growing from single channel analysis, to full 
interaction, multi-channel analysis with a common data model and user interfaces across 
these systems. Operational Analyst is a required component of Interaction Center 6.0, 
functioning as its Operational Data Store and Contact Center Performance Analysis 
system, replacing and significantly upgrading the reporting capabilities of Interaction 
Center 5.6. Operational Analyst is also an optional, add-on to Avaya Call Management 
System (CMS) for extended, online historical data storage and multi-site analysis, pulling 
External Call History data from up to 30 CMS systems representing 240 MultiVantage 
ACDs.

Operational Analyst has been rigorously tested so encountering difficulties while using the 
system is unlikely. However, in the event of such an occurrence, this Guide provides hints 
about ways to troubleshoot the system to determine the exact nature of the difficulty. Many 
of these steps are valuable in administering your Operational Analyst system during the 
course of normal operation. Troubleshooting overview for this process.

To expedite location of the information you are looking for, the remainder of this Guide is 
grouped into chapters and related topics. These chapters relate to major pieces of 
Operational Analyst functionality and include:

� OA Administration Client

� OA Basic Reports

� OA Features

Note:
If you cannot find your problem described in the troubleshooting section, 
contact Avaya Customer Support.
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Chapter 1: Troubleshooting overview

This chapter presents a suggested map for troubleshooting an Operational Analyst system 
and information about how Avaya Customer Support can assist your troubleshooting 
efforts remotely. 

Following the troubleshooting map steps in order helps to narrow the point of difficulty from 
broad, system-related areas to more specific targets like individual processes. The map 
contains references to other sections of the Troubleshooting Guide for more detailed 
information. See Troubleshooting map on page 10 to get started.

The remote access option is available to you if you are running on a Windows platform. 
See Remote access on page 12.

Tip:
Many sections throughout this manual specify file path names. Generally the 
MS Windows notation %PABASE% and \ is used when defining path 
names. If your system is running on a Solaris platform, substitute $PABASE 
and / respectively for %PABASE% and \.
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Troubleshooting map
For best results, you should follow the map in the order given.

1. Check the Windows Event Log or Solaris CentralErrorLog.log file for messages that 
indicate particular problems. See Error messages on page 139 for details about 
locating and reading the logs.

2. Verify Avaya Business Intelligence Service and ORBacus Naming Service are 
running.

� On Windows NT: Settings > Control Panel > Services.

� On Windows 2000: Settings > Control Panel > Administrative Tools > Services.

If the services are not running, start them. If they do not start, use the Event Viewer 
to debug the system.

� On Solaris: From the command line enter ps -ef|grep initserv and 
ps -ef|grep namesrv. 

If the services are not running, as root check the /etc/inittab settings and verify 
initserv and namesrv are set to respawn, write the file, and enter init q to restart 
the services.

If the services do not start, use the trace files to debug the system. See Trace 
files on page 113 for more information.

3. Once Avaya Business Intelligence Service and ORBacus Naming Service are 
running, verify Master Operations Manager (MOM) is running.

� From the command line enter pa list.

If the message returned is a list of processes, MOM is running.

If the message returned is mom is not active, enter pa start all.

� See Master Operations Manager on page 106 for more information about MOM.

4. When MOM is running, verify other Operational Analyst processes and services are 
running.

� Edit %PABASE%\data\admin\server.properties to verify which subsystems are 
installed on this machine. For example, if the historical subsystem is installed, the 
entry AOA_Historical is set to true. If it is set to false, then the historical 
subsystem is not installed.

� Verify the base Operational Analyst services are running via the pa command: 

� admb, adm0, ams, and aut for all servers.

� schd for the historical server. 

� Verify other processes are running based on values in the server.properties file. 
For example, the dm and dsvr processes should be running if the real-time system 
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is installed. Use the pa command to enable a process if it is not running. See 
Processes on page 106 for more information on processes and the pa command.

� Verify that any previously administered forwarders, recorders, or forwarder-
recorders are running (and which server they are running on) using the Interface 
Services screen of the Administration Client. If not running, enable the services 
through this same screen. See the Administration Client Help for information about 
using the Interface Services screen.

� If a process does not start, check the Windows Event Log or Solaris 
CentralErrorLog.log for messages indicating particular problems. You may need 
to view the trace files to locate the problem. See Trace files on page 113 for more 
information.

5. If you cannot find a process that you think should be running, verify the administration 
of the system through the Administration Client Subsystems and Interface Services 
screens. See the Administration Client Help for information about using the 
Administration Client Subsystems and Interface Services screens.
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Remote access
Avaya Customer Support representatives can access your Operational Analyst system 
remotely to assist with troubleshooting if you are running on Windows NT or Windows 
2000. To enable this service, you must install pcAnywhere software, version 10.5 or later, 
on the systems requiring remote access.

Before installing pcAnywhere, install a standard modem and its associated driver. Verify 
the modem is accessible to the system via the Control Panel. Set the modem parameters 
according to this table:

Refer to the modem documentation for details on configuring these parameters.

Refer to the pcAnywhere documentation for installation instructions.

Modem parameter Value

Data Terminal Ready On

Carrier Detect On

Auto Answer On

Display Result Codes Off



Issue 1.0 August, 2002 13

Chapter 2: OA Administration Client

This chapter provides some tips on troubleshooting the Administration Client. Here you 
can find information about various error messages you may see, and explanations of 
behaviors you may encounter.

The major topics included here are:

� General Administration Client Issues on page 14 deals with a variety of problems that 
you might encounter. It includes �hangs,� long waits and data entry problems.

� Administration Client Java plug-in and Java console on page 21 concentrates on Java 
Console configurations that may aid you in resolving Administration Client initialization 
issues.

� Administration Client log files on page 23 describes how you can use the log files to 
identify problems as well as explain the log errors.

� Administration Client administration screens on page 31 lists problems that you may 
encounter with a particular administration screen, with corresponding solutions.

� Administration Client status messages on page 36 explains what the status messages 
mean.

� Administration Client error messages on page 39 lists error dialogs that you might 
encounter and provides suggestions on how you might resolve the errors.
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General Administration Client Issues
This portion of the chapter lists a collection of common problems and their solutions. It 
focuses on issues that you might encounter while launching the Administration Client or 
while using it. It deals with any difficulty that is not specific to an Administration Client 
module or an administration screen.

General Administration Client issues include:

Client not updated on page 14

Connectivity on page 14

Data Entry on page 15

General Protection Faults on page 16

Initialization Errors on page 17

Long wait time on page 18

Page faults on page 20

Printing on page 20

Unresponsive system on page 20

Client not updated
Operational Analyst does not update the configuration data displayed in the Administration 
Client automatically. Refresh the administration screen often by clicking View > Refresh 
on the Administration Client menu.

Operational Analyst allows up to five Administration Clients to connect to the server 
simultaneously. It does not lock any user out and keep him or her from administering the 
data. If more than one person is administering the Administration Client, the first one to 
save the configuration settings will have his or her entries saved; the other administrators 
will have their entries rejected. This is because the update value of the first person 
matches the value in the database, while the update values of the subsequent users are 
out of sync with the database (because the first person has already changed the value). 
This first-person rule prevents other users from destroying the initial changes another user 
has made. Refresh your administration screen periodically to ascertain that you are 
working with the latest configuration.

Connectivity
The Administration Client establishes a CORBA connection when you launch it. The 
connection may break if you are not using the Administration Client for a while (a �time-
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out�). You can re-establish the CORBA connection by clicking File > Reconnect in the 
Administration Client menu.

If the problem persists and an error message notifies you that the server is unavailable, 
close your Internet Explorer browser, then relaunch the Administration Client.

Data Entry

Symptom Description Resolution

The Administration 
Client is not 
recognizing my 
shortcut keys.

Your entries 
might be applying 
to the browser 
and not the 
Administration 
Client.

Click anywhere within 
the administration 
screen or a dialog box 
to activate the 
shortcut keys and to 
start entering your 
configuration.
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General Protection Faults
General Protection Faults (GPF) happen when an application, such as the Administration 
Client, attempts to read or write data that is outside its permission rights.

You can track down the GPFs by eliminating suspects one by one.

The Administration 
Client is not 
accepting my input.

Your entries 
might be applying 
to the browser 
and not the 
Administration 
Client.

Click anywhere within 
the administration 
screen or a dialog box 
to activate the 
shortcut keys and to 
start entering your 
configuration.

The text boxes are 
not accepting my 
input. It accepts the 
first few digits, but 
not the succeeding 
ones.

The text boxes 
have a defined 
minimum and 
maximum range.

If you enter a value 
larger than the 
maximum permissible 
value, the 
Administration Client 
will not display the 
digit where you have 
exceeded the limit.
For example, the 
Rules per container 
filter text box in the 
Container Limits 
administration screen 
has a range of 1-100. 
If you enter 101 into 
the text box, the client 
will only display 10 no 
matter how many 
times you enter the 
last digit.
If you enter a value 
below the minimum, 
the client will either 
not display your entry 
or convert your entry 
to the minimum value 
when you move on to 
the next field.

Symptom Description Resolution
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To isolate the source:

1. Shut down all applications one at a time ending with Internet Explorer.

2. If the GPF persists, re-launch the Administration Client from Internet Explorer. Type in 
C:\Program Files\Avaya\BI\AdminPol.html (if you did not use the default 
installation, enter the appropriate address) in the Address text box.

An alternative solution is to change your computer's system video mode to use the 
Windows standard VGA driver (16 color VGA). If this solves your problem, then your 
original video driver may have problems. Contact your video card vendor for an updated 
video driver.

Initialization Errors
If the Administration Client does not seem to be initializing, it might either be not 
responding or is experiencing initialization errors.

Check the Windows Task Manager to see if the Administration Client has stopped 
responding. If that is not the issue, close the Administration Client, open the Java Console 
and open the Administration Client again to see if initialization errors are still occurring.

Initialization errors are most likely caused by problems with the system environment. It 
might be a security problem (policy files), invalid installation file structure (missing 
directories or files), invalid file permissions (read only), incomplete environment variable 
specification (PATH), missing or unregistered libraries, or corrupt jar files.

The PATH is set during installation and initial set-up. For more information, see the 
Operational Analyst Installation and Maintenance Guide.
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Long wait time

Symptom Description Resolution

The 
Administration 
Client takes a 
long time to load.

The Administration Client does not 
load.

Re-launch your browser and 
the Administration Client.

The Java Console is empty. It may 
display the following text 
immediately after the Administration 
Client initializes:
Java(TM) Plug-in: Version 
1.3.1_01
Using JRE version 1.3.1_01
Java HotSpot(TM) Client VM
User home directory = 
C:\WINNT\Profiles\...
Proxy Configuration: Manual 
Configuration
Proxy: co.proxy.avaya.com:8000
Proxy Overrides: *.avaya.com, 
<local>
Jar cache enabled.
Initializing the OA admin client 
applet...

The Administration Client 
cannot find the Java Security 
Plug-in, therefore it tries to 
download the plug-in form 
Sun Microsystems. This may 
take a while to complete.
The Administration Client 
launches as soon as the 
download is complete and 
the plug-in is available.
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The 
Administration 
Client is taking a 
long time to load 
and is not 
generating error 
messages.

The Administration Client is 
responding and is not reporting or 
logging errors.

This might be an initialization 
error or an unresponsive 
system (hang) problem.
Close the Administration 
Client then start the Java 
Console. Start the 
Administration Client again 
and look at the Java Console 
error log.
If it appears to be an 
initialization error, check the 
environment.
The most likely cause of this 
error is an improperly set or 
incomplete environment 
variable specification 
(PATH). The PATH is set 
during installation and initial 
set-up. For more information, 
see the Operational Analyst 
Installation and Maintenance 
Guide.
If this is not the source of the 
error, you may have a 
security problem (invalid or 
missing policy files), invalid 
installation file structure 
(missing directories or files), 
invalid file permissions, 
missing or unregistered 
libraries, or corrupt jar files.
If the Java Console does not 
display any output, refer to 
the solution proposed above.
Also refer to Initialization 
Errors on page 17.

Symptom Description Resolution
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Page faults
Page faults occur when your computer is low on RAM or swap file space. You must either 
increase the RAM or the swap file size.

Printing
You cannot print the Administration Client user interface (UI) by using the Print menu in 
the browser or by pressing the Ctrl (Control) and P keys.

To print the Administration Client UI, select File > Print in the Administration Client menu 
bar.

Unresponsive system
Sometimes the Administration Client does not respond to your input. To determine whether 
the Administration Client is just taking a long time to process input or is not responding, 
use Windows Task Manager. 

This table lists a few things you can do when the Administration Client freezes.

Symptom Description Resolution

JRE Plug-in freezes The Java Console is 
completely empty.
JRE 1.2.2 version 005 and 
006 have unresponsive-
system issues.

Upgrade to JRE 1.3.1_01.

The Java Console is 
completely empty and a 
download dialog box 
appears.
A Java Console in debug 
mode may cause this.

Disable debugging.

To disable debugging:

1. Go to the Java Plug-in 
Control Panel.

2. Select the Advanced 
tab.

3. Clear the Enable 
Debug check box.

4. Click Apply.

5. Close the Java Plug-in 
Control Panel.
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Administration Client Java plug-in and Java console
As an additional troubleshooting aid, the Administration Client logs messages in the Java 
Security Plug-in Java console window. The Java Console helps you diagnose problems 
that might occur when the applet initializes.

This chapter provides information to help you use the Java Console. Topics in this chapter 
include:

Accessing the Java Plug-in Control Panel on page 21

Enabling the Java Console on page 21

Recycle Classloader on page 22

Accessing the Java Plug-in Control Panel
The Java Plug-in Control Panel lets you configure the security plug-in, the Java console, 
and Jar caching. You need to use the control panel to troubleshoot certain problems.

To access the Java Plug-in Control Panel (JRE 1.3) in Windows:

1. Select Start > Settings > Control Panel.
2. Double-click the Java Plug-in icon.

The Java Plug-in Control Panel launches.

Enabling the Java Console
You can view the Java Console to troubleshoot initialization errors.

Tip:
The Java Console, while useful for diagnosing problems, need not be 
enabled under normal operations.

To enable the Java Console:

1. Launch the Java Plug-in Control Panel.

2. In the Basic tab, select Show Java Console.

3. Click Apply, then close the window.

4. Re-launch the Administration Client.

The Java Console appears when the Administration Client is starting.

Tip:
To disable the Java console, follow the procedure above except to clear the 
Show Java Console check box. 
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Recycle Classloader
Enable the Recycle Classloader option so you can launch the Administration Client more 
than once from one browser.

To recycle the classloader:

1. Launch the Java Plug-in Control Panel.

2. In the Basic tab, select Recycle classloader.
3. Click Apply, then close the window.

4. Restart the Administration Client.

Tip:
To disable recycling of classloader, follow the procedure above except to 
clear the Recycle classloader check box. 
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Administration Client log files
If you are baffled about why the system is not working as it should, you may want to look at 
the trace files.

The Administration Client trace files are in %PABASE%\data\log\adminclient\. If you 
installed OA in the default directory, that would be C:\Program 
Files\Avaya\BI\data\logadminclient\.

Configuring the log files
You can customize your trace files to give more or less information. This level of detail is 
configured in two places: the loginfo file and the Admin.html file. The sections below 
detail how you can modify them to suit your needs

Loginfo

You can change the size and roll-over of the trace file. The file is in 
%PABASE%\data\admin\. (If you selected the default location during installation, that 
would be: C:\Program Files\Avaya\BI\data\admin.)

The entry in the loginfo file might look like this:

adminClientTrace data/log/adminclient/adminClientTrc 150000 3

where:

� adminClientTrace is the name of the entry. Do not change this value.

� data/log/adminclient/adminClientTrc is the directory location of the trace file. 
Do not change this value.

� 150000 is the maximum size of the trace file. You may specify this value to be whatever 
is appropriate for your needs.

� 3 is the roll over count. You specify the value you want.

When a trace file reaches the maximum size, it rolls over. This means that the current 
trace file is renamed with an .nn extension (where .nn is a number). For example, 
adminClientTrc-1 becomes adminClientTrc1.01 when it reaches the maximum limit. If 
there already is an adminClientTrc1.01, then that existing file becomes 
adminClientTrc1.02. While the logged messages are rolling over, Operational Analyst 
continues logging the latest messages on the original file (which in this case is: 
adminClientTrc-1).
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Tip:
To determine which client trace file is being used, click View > Trace File 
Location in the Administration Client menu bar. The Administration Client 
displays the name and location of the trace file it is using.

AdminPol.html

You can change the detail level of your trace file as well as activate the CORBA tracing. If 
you selected the default location during installation, this file would be in C:\Program 
Files\Avaya\BI\.

Error types and codes
Operational Analyst logs an error in the following conditions:

� The Administration Client cannot access required resources, such as the resource 
bundles for internationalization.

� The Administration Client cannot get a server connection.

� The Administration Client is not in sync with the Operational Analyst server.

� CORBA exceptions are caught.

This table lists error types the Administration Client uses:

Attribute Description Default 
Value

Possible Values

TRACE_LEVEL Specifies the level of 
trace information to 
collect

10 10 - Event level 
trace.

20 - Interface level 
trace.

30 - Debug level 
trace. This produces 
the highest number 
of trace messages.

CORBA_TRACE Enables CORBA 
tracing.
Enabling this results 
in a voluminous trace 
log. Turn on only 
when necessary.

No Yes

No
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Administration Client error codes

This table lists error codes related to the Administration Client.

ID Error Type

1050 to 1100 Database error codes

4101 to 4300 Common CORBA error codes

4301 to 4400 Common object error codes

11801 to 11900 Registration error codes

12001 to 12100 Administration Client error codes

12101 to 12200 Administration Client-server error codes

12301 to 12400 Metadata error codes

12701 to 12800 Migration error codes

12801 to 12900 Maximum capacity error codes

13101 to 13200 Scheduling error codes
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Error Code Description Resolution

AC_INTERNAL_ERROR 
(12003)

Internal error. This 
generally indicates one of 
the following types of 
errors:

� The code is out of 
sync with UI (user 
interface) files (.gui).

� What the 
Administration Client 
supports is out of 
sync with what the 
server supports.

� Page and server 
access classes are 
out of sync.

� Missing objects within 
the client (null).

� Unknown server error 
code received by 
Administration Client.

Contact Avaya customer 
support and report the 
error. The representative 
will contact the appropriate 
developers.



Administration Client log files

Issue 1.0 August, 2002 27

Administration Client-server error codes

This table lists error codes related to the Administration Client-server issues.

AC_LOST_CONNECTION 
(12002)

The Administration Client 
cannot establish 
connection with the 
server.

Reconnect by clicking File 
Reconnect on the 
Administration Client menu 
bar.
If this error persists, make 
sure that the server is 
running and the 
AdminMgrSrvBase 
process is executing.
If the AdminMgrSrvBase 
process cannot create 
AdminMgrSrv processes, 
the Administration Client 
will not be able to connect 
to the server.
Check the log file to see if 
there are other errors, such 
as ORB initialization 
failures, which could result 
from improperly-set 
classpath or policy files.
The classpath is set in 
Start >Settings > Control 
Panel > System 
Environment during 
installation and initial set-
up. For more information, 
see the Operational 
Analyst Installation and 
Maintenance Manual.

AC_MISSING_RESOURCES 
(12001)

The Administration Client 
cannot find the language 
resource bundles needed 
to execute.

Contact Avaya customer 
support and report the 
error. The representative 
will contact the appropriate 
developers.

Error Code Description Resolution
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CORBA error codes

This table lists error codes related to CORBA issues.

Error Code Description Resolution

ADMIN_DATABASE_UNAVAILABLE 
(12102)

The database is not 
available.

Investigate the server logs 
to determine why the 
database is unavailable. It 
could be because:

� The database is down

� The JDBC driver is not 
able to connect

� Allowed database 
connections are 
exhausted

ADMIN_INVALID_IDL_VERSION 
(12106)

The Administration 
Client and 
Administration 
Manager server 
component use IDL to 
communicate with 
each other.
The client and server 
must use compatible 
versions of the IDL. 
Incompatible versions 
result in this error.

Upgrade either the 
Administration Client or the 
server�or both.

ADMIN_SERVER_CONFIG_NOT_KN
OWN (12158)

The administration 
client could not get 
the server 
configuration from the 
historical server.

This could be a 
connectivity problem, or an 
installation problem.

ADMIN_SVC_DISABLE_OVERRIDE 
(12160)

The administrator has 
decided to delete or 
modify a subsystem 
that has services in 
an enabled or 
unknown state.

Manual cleanup of 
interface services that 
were not disabled prior to 
subsystem modification or 
deletion may be needed.
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Common objects error codes

This table lists error codes related to common objects.

Error Code Description Resolution

CORBA_EXCEPTION 
(4201)

ORB initialization failure. 
The server connection 
could not be established.

Reconnect by clicking File > 
Reconnect in the menu bar. 
This will not work until the 
underlying problem is fixed.
The most likely cause of this 
error is an improperly set 
CLASSPATH environment 
variable. It is set in Start > 
Settings > Control Panel > 
System Environment during 
installation and initial set-up. 
For more information, see the 
Operational Analyst 
Installation and Maintenance 
Manual.

ORBIX_NARROW 
(4108)

The Administration Client 
cannot establish a 
connection because it is 
unable to get the right 
version of server object to 
connect.

The AdminMgrSrv process 
could not be created. This may 
either be a server problem or a 
CORBA problem.
Investigate the Administration 
Client and server trace files to 
determine the cause.

ORBIX_NS_BIND 
(4104)

The Administration Client is 
unable to bind to the 
AdminMgrSrvBase server 
process while attempting to 
connect.

The Administration Client 
attempt this operation three 
times before failing. 
Connection failure may be 
because of a 
AdminMgrSrvBase server 
process that is not running or a 
CORBA problem.
Investigate the Administration 
Client and server trace files to 
determine the cause.
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Registration error codes

This table lists error codes related to registration.

Error Codes Description Resolution

OBJ_INVALID_STATE 
(4301)
OBJ_INVALID_VALUE 
(4302)

The server returned an 
invalid value to the 
Administration Client.

Contact Avaya customer support 
and report the error. The 
representative will contact the 
appropriate developers.

Error Codes Description Resolution

REG_INVALID_SUBSYSTEM 
(11817)

Internal error. The 
Administration Client 
received an 
unknown subsystem 
type.

Contact Avaya customer 
support and report the error. 
The representative will contact 
the appropriate developers.
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Administration Client administration screens
This chapter addresses some of the common problems you might encounter while 
managing your data in the administration screen.

Container Profiles

Interface Services

Problem Description Resolution

The Administration 
Client does not allow 
you to enable or disable 
a container.

You can only have 
a limited number of 
enabled or disabled 
containers. This 
restriction is 
configured in the 
Container Limits 
administration 
screen.

Change the 
configuration in 
Container Limits. 
If you have already 
reached the maximum 
number of enabled and 
disabled containers 
permitted by Operational 
Analyst and cannot add 
more, then you must 
delete some containers. 
You must disable 
containers first before 
you can delete them. 

Problem Description Resolution

Changes to interface 
services are not recognized.

Another administrator might 
have saved changes and 
your administration screen 
is not reflecting the latest 
configuration settings.

Refresh the screen by 
clicking View > Refresh 
on the Administration 
Client menu.
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Interface services are not 
synchronized.

When the server and the 
Administration Client hold 
different information about a 
service, they are not 
synchronized. 
Synchronization has failed.
You can monitor the 
synchronization status of 
your interface services in 
the Synchronized column 
of the Interface Services 
results screen. 

Disable then re-enable the 
service.
If this does not clear the 
problem because the 
service is unreachable 
(the service state is 
displayed in the Status 
column of the Interface 
Services screen), you 
must manually disable and 
enable the service in the 
command line:

1. Navigate to the 
Interface Services 
administration 
screen.

2. Look up the interface 
service name in the 
Name column. 

3. Log into the 
subsystem host 
where the wayward 
service is located.

4. Disable the service 
with this command: 
pa disable 
<name>.

5. Re-enable the 
service with this 
command: pa enable 
<name>.

What is the interface service 
name?

You need to know the 
interface service name if 
you wish to do something 
with an interface service 
over the command line.
The interface service name 
is an internally assigned 
name the server uses to 
identify the service. You 
cannot modify the name.

To find the interface 
service name, Navigate to 
the Interface Services 
administration screen and 
look up the interface 
service name in the Name 
column.
Use the name to 
troubleshoot the interface 
service.

Problem Description Resolution
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Subsystems

Cannot modify, enable, or 
disable a service (buttons 
are grayed out)

Modify/enable/disable are 
not allowed until the status 
of the service is known.

Select services from table 
(highlight them) and select 
View status.

Cannot select all services to 
get status.

Services can only be 
selected one at a time.

Select Edit > Select All or 
Edit > Select None to 
select or deselect all 
services.

Problem Description Resolution

Problem Description Resolution

The Administration Client 
does not accept the 
subsystem configuration.

The subsystem name must 
be unique.

Enter a unique name.

Cannot add a report 
subsystem.

Operational Analyst 
supports no more than two 
report subsystems total, 
and no more than one 
report subsystem on any 
server.

Do not exceed these 
constraints.

Cannot add a real-time 
subsystem.

Operational Analyst 
supports no more than two 
real-time subsystems on a 
server. A real-time 
subsystem cannot reside 
on a server where a CMS 
subsystem is already 
installed.

Do not exceed these 
constraints.

Cannot add a historical 
subsystem.

Operational Analyst allows 
only 1 historical subsystem, 
which is created during the 
OA installation process.
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Cannot add a CMS 
subsystem.

CMS subsystems are 
subject to these 
constraints:
� Only one CMS 

subsystem per server.
� CMS subsystems cannot 

be added to servers 
where a historical 
subsystem is already 
assigned.

� CMS subsystems cannot 
be added to servers 
where a real-time 
subsystem is already 
assigned.

Cannot add an IC source 
subsystem.

Only one IC source 
subsystem is allowed per 
real-time subsystem.

Add a new real-time 
subsystem to support the 
new IC source subsystem, 
then add the IC source 
subsystem.

Cannot add an ACD 
source subsystem.

A CMS subsystem supports 
a maximum of eight ACD 
source subsystems.

Add a new CMS subsystem, 
the add the ACD source 
subsystem.

Cannot delete an ACD 
source subsystem.

The system scheduled job 
cannot be deleted, so the 
subsystem cannot be 
deleted.

Disable the system 
scheduled job.

Cannot delete or modify 
a subsystem.

There are services 
associated with the 
subsystem in an enabled or 
unknown state. These 
services will be deleted 
from the OA database, 
leaving them inaccessible 
from the Administration 
Client.

Disable all associated 
services before deleting the 
subsystem. If you choose 
not to disable the services, 
they may become 
inaccessible from the client 
and remain in an executing 
status on the server.

Problem Description Resolution
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Cannot delete a CMS or 
real-time subsystem.

The subsystem has 
associated source 
subsystems.

Delete or reassign the 
source subsystems to a 
new CMS or real-time 
subsystem.

Cannot delete a historical 
subsystem.

Operational Analyst does 
not allow the historical 
subsystem to be deleted.

Problem Description Resolution
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Administration Client status messages
This chapter describes and explains some status messages you might receive while using 
the Operational Analyst Administration Client.

Interface services

Status Message Description

Change(s) cancelled. Ready. Your changes have been removed and 
are not going to be sent to the server.

Disabling services may result 
in the loss of data.

Disabling the interface service stops it 
from running and might result in lost 
data.Some interface services have pre-
administered buffer space that mitigates 
data loss for brief periods of time.

Modifying this service may 
result in the loss of data.

Because you need to disable an 
interface service when you modify it, 
data might be lost.

One or more changes failed. 
Ready.

One or more changes failed on the 
server.

Pressing the Cancel button 
causes all unsaved 
administration changes to be 
deleted.

All the changes you made since the last 
save will be discarded.

Retrieving data from server. The Administration Client is waiting for 
the server to send it requested data.

Sending change(s) to the 
server.

The Administration Client is sending 
your changes to the server.

There are unsaved 
administration changes for this 
screen.

You have not saved your changes.
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Schemas

Status Message Description

A migration has started. The 
schema can't be accessed at 
this time.

Operational Analyst is migrating 
data from one table to another, 
therefore you cannot view the 
schema. 
Wait until he migration is done.

Could not get requested data 
from the server. Please try 
again later.

The server data is not available. 
Try your request again later.

Change(s) cancelled. Ready. Your changes have been 
removed and not sent to the 
server.

Change failed. Ready. Your change request failed. try 
again.

Change(s) succeeded. Ready. Your change request is 
successfully being sent to the 
server. You may now make more 
changes.

Current and Pending schemas 
exist. Current schema can only 
be viewed.

When both current and pending 
schemas for a historical store 
exist, you can only view the 
current schema and not modify it.
If you want to modify your 
schema, make your changes to 
the pending schema.

Migration in progress. Current 
schema can only be viewed 
until the migration completes.

Operational Analyst is migrating 
data from one table to another, 
therefore you cannot view the 
schema.
Wait until he migration is done.

Retrieving data from server. The Administration Client is 
waiting for the server to send it 
the requested data.

Save cancelled at user's 
request.

The changes were not sent to the 
server at your request.



OA Administration Client

38 Operational Analyst Troubleshooting Guide

Sending change(s) to the 
server.

The Administration Client is 
sending your changes to the 
server.

There are unsaved 
administration changes for 
this screen.

You have not saved your 
changes.

Status Message Description
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Administration Client error messages
This chapter describes and explains some error messages you might receive while using 
the Operational Analyst Administration Client.

Note:
Some of the descriptions and resolutions proposed are vague because the 
problems arise out of third-party software or defective hardware. You may 
need to look at the other vendors' troubleshooting documentation or contact 
their technical support department.

Connection

Error Message Description Resolution

A connection to the 
server database 
can't be created. 
Administration can't 
be done without a 
database 
connection.

Operational Analyst could 
not establish a database 
connection.
The Administration Client 
needs a database 
connection to send your 
administration requests.

Try again.
If the problem persists, 
contact your support 
organization to troubleshoot 
the database connection 
error.

Administration 
Client couldn't 
connect to server.

The Administration Client 
cannot establish a 
connection with the 
server

See Connectivity on page 14.

Administration 
Client received 
unexpected 
exception.

The Administration Client 
caught an unexpected 
exception during 
construction. This is 
generally an exception 
generated by the server 
when it encounters 
problems while the 
Administration Client is 
connected to it.

Try again. If this problem 
persists, contact customer 
support.
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Administration 
Client couldn't 
connect to server 
due to ORB initialize 
failure.

The Administration Client 
could not initialize the 
Object Request Broker.

The most likely cause of this 
error is an improperly set 
CLASSPATH environment 
variable. It is set in Start > 
Settings > Control Panel > 
System Environment during 
installation and initial set-up. 
For more information, see the 
Operational Analyst 
Installation and Maintenance 
Manual.
See also Initialization 
Errors on page 17.

Server connection 
has been lost due to 
a CORBA failure. To 
continue, please 
reconnect.

CORBA failure occurred 
during initialization.

Reconnect to the server by 
clicking File > Reconnect in 
the Administration Client 
menu bar.

The maximum 
number of allowed 
client/server 
connections are 
currently in use. 
This client can't 
connect to the 
server until another 
client exists. Please 
try again later.

Operational Analyst 
allows a maximum of 10 
Administration Clients to 
connect to the server.

Try again later, when there 
are not as many 
Administration Client users.

Error Message Description Resolution
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There is a problem 
with the server 
connection. Please 
exit this dialog.

The server connection 
has been lost.

Reconnect to the server by 
clicking File > Reconnect in 
the Administration Client 
menu bar.

Use File > 
Reconnect to 
reconnect. If this 
problem persists 
contact your support 
organization.

The client-server 
connection is lost or 
could not be established.
This might be a 
temporary problem or a 
CORBA problem.

Reconnect to the server by 
clicking File > Reconnect in 
the Administration Client 
menu bar.
If this does not work, check 
the system environment to 
make sure that the problem is 
not due to an improperly set 
CLASSPATH environment 
variable.
The CLASSPATH is set in 
Start > Settings > Control 
Panel > System > 
Environment during 
installation and initial set-up. 
For more information, see the 
Operational Analyst 
Installation and Maintenance 
Manual.
See also Initialization 
Errors on page 17.

Error Message Description Resolution
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Containers

Error Message Description Resolution

Containers are currently 
defined which have 
more entities than the 
proposed limit allows.

You have reached the 
maximum number of 
containers allowed in the 
Operational Analyst 
system.

Operational Analyst limits the 
number of containers you can 
have for each historical store.
This limit is set in the 
Container Limits 
administration screen. You can 
either change the container 
limit or delete some 
containers.

Container name 
contains illegal 
character: \ / { ' " or Esc.

The container name 
contains one or more 
illegal characters.

Do not use \ / { ' " or Esc when 
you name your container.

Container name exceeds 
maximum length of 40 
characters.

The container name is 
too long. The 
Administration Client 
allows a maximum of 40 
characters

Give the container a shorter 
name.

The following container 
name is not unique:

The container name is 
not unique.

Give the container a unique 
name.
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Container Limits
Some of the descriptions and resolutions proposed here are vague because the problems 
arise out of third-party software or defective hardware. You may need to look at the other 
vendors' troubleshooting documentation or contact their technical support department.

There are currently more 
disabled containers than 
the proposed limit 
allows.

You have reached the 
maximum number of 
disabled containers 
allowed in the 
Operational Analyst 
system.

Operational Analyst limits the 
number of disabled containers 
you can have for each 
historical store.
This limit is set in the 
Container Limits 
administration screen. You can 
either change the disabled 
container limit or delete some 
containers.

There are currently more 
enabled containers than 
the proposed limit 
allows.

You have reached the 
maximum number of 
enabled containers 
allowed in the 
Operational Analyst 
system.

Operational Analyst limits the 
number of enabled containers 
you can have for each 
historical store.
This limit is set in the 
Container Limits 
administration screen. You can 
either change the enabled 
container limit, disable some 
containers or delete them.

Error Message Description Resolution

Error Message Description Resolution

An external user has 
corrupted the data for 
the historical 
subsystem.

Another user might have 
corrupted the historical 
subsystem.

Determine the damage and 
repair it.
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Containers are 
currently defined 
which have more 
entities than the 
proposed limit allows.

You have reached the 
maximum number of 
containers allowed in the 
Operational Analyst system.

Operational Analyst limits 
the number of containers 
you can have for each 
historical store.
This limit is set in the 
Container Limits 
administration screen. 
Either change the container 
limit or delete some 
containers.

Internal server error or 
client and server are 
out of sync. Contact 
your support 
organization.

Either an internal server error 
occurred or the Administration 
Client and the server are out 
of sync. The asynchronism is 
most likely caused by differing 
client and server software 
versions.

Upgrade the software 
version in your client or 
server.

Server error occurred, 
please try again. If this 
error continues, 
contact your support 
organization.

A server error occurred. Try again.
If the problem persists, 
contact your support 
organization to troubleshoot 
the server error.

There are currently 
more disabled 
containers than the 
proposed limit allows.

You have reached the 
maximum number of disabled 
containers allowed in the 
Operational Analyst system

Operational Analyst limits 
the number of disabled 
containers you can have for 
each historical store.
This limit is set in the 
Container Limits 
administration screen. 
Either change the disabled 
container limit or delete 
some containers.

Error Message Description Resolution
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Daily Intervals
Some of the descriptions and resolutions proposed here are vague because the problems 
arise out of third-party software or defective hardware. You may need to look at the other 
vendors' troubleshooting documentation or contact their technical support department.

There are currently 
more enabled 
containers than the 
proposed limit allows.

You have reached the 
maximum number of enabled 
containers allowed in the 
Operational Analyst system.

Operational Analyst limits 
the number of enabled 
containers you can have for 
each historical store.
This limit is set in the 
Container Limits 
administration screen. 
Either change the enabled 
container limit, disable 
some containers or delete 
them.

This request is 
inconsistent with the 
server database. 
Please refresh and try 
again.

Operational Analyst allows 
multiple Administration Clients 
to connect to the server 
simultaneously but does not 
automatically update the 
administration data.
Someone else has changed 
the configuration settings and 
your Administration Client is 
not reflecting the latest 
administration data.

Refresh your administration 
screen by clicking View > 
Refresh on the 
Administration Client menu.
For more details, see Client 
not updated on page 14.

Unknown error 
received from server, 
error index number: 
xxxxx

The Administration Client and 
the administration server 
components are out of sync.

Try again, if problem 
persists, contact Avaya 
customer support.

Error Message Description Resolution

Error Message Description Resolution

Fixed Interval name 
specified is not unique. 
Specify a unique name.

The daily interval name is 
not unique.

Give the daily interval a 
unique name.
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Database and data access
Persistent database problems might be generated by third-party applications, flawed 
configuration, or faulty hardware. Consult the appropriate troubleshooting documentation.

Fixed Interval start time 
specified has already 
been used. Specify an 
unused start time.

You have already defined a 
daily interval with the same 
start time.

Specify a different start time 
or not create a duplicate daily 
interval.

Internal server error or 
client and server are 
out of sync. Contact 
support.

Either an internal server 
error occurred or the 
Administration Client and 
the server are out of sync. 
The asynchronism is most 
likely caused by differing 
client and server software 
versions.

Upgrade the software version 
in your client or server.

This request is 
inconsistent with the 
server database. Please 
refresh and try again.

Operational Analyst allows 
multiple Administration 
Clients to connect to the 
server simultaneously but 
does not automatically 
update the administration 
data.
Someone else has changed 
the configuration settings 
and your Administration 
Client is not reflecting the 
latest administration data.

Refresh your administration 
screen by clicking View > 
Refresh on the 
Administration Client menu.
For more details, see Client 
not updated on page 14.

Unknown error 
received from server, 
error index number: 
xxxxx

The Administration Client 
and the administration 
server components are out 
of sync.

Try again, if problem persists, 
contact Avaya customer 
support.

Error Message Description Resolution
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Error Message Description Resolution

A connection to the 
server database can't be 
created. Administration 
can't be done without a 
database connection.

Operational Analyst could 
not establish a database 
connection.
The Administration Client 
must have a database 
connection to send your 
administration requests.

Try again.
If the problem persists, 
contact your support 
organization to troubleshoot 
the database connection 
error.

Can't access the 
database at this time. 
Please try again later.

Operational Analyst could 
not access the database.

Try again later.
If the problem persists, 
contact your support 
organization to troubleshoot 
the database connection 
error.

Data could not be 
accessed on the server. 
If this condition 
persists, contact your 
support organization.

Operational Analyst could 
not access the database.

Reconnect by clicking File > 
Reconnect in the 
Administration Client menu.
See also Connectivity on 
page 14.

Database SQL error 
occurred. If this error 
continues, contact your 
support organization.

An SQL error occurred on 
the server.

Contact your support 
organization to troubleshoot 
the SQL error.

Database update failed, 
please try again. If this 
error continues, contact 
your support 
organization.

The database update failed. Try again.
If the problem persists, 
contact your support 
organization to troubleshoot 
the database connection 
error.
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General
This section pertains to error messages that you might encounter while using any of the 
Operational Analyst administration screens.

Server connection has 
been lost due to a 
CORBA failure.

CORBA failure occurred 
during initialization.

Contact Avaya customer 
support.

This request is 
inconsistent with the 
server database. Please 
refresh and try again.

Operational Analyst allows 
multiple Administration 
Clients to connect to the 
server simultaneously but 
does not automatically 
update the administration 
data.
Someone else has changed 
the configuration settings 
and your Administration 
Client is not reflecting the 
latest administration data.

Refresh your administration 
screen by clicking View > 
Refresh on the 
Administration Client menu.
For more details, see Client 
not updated on page 14.

Error Message Description Resolution

Error Message Description Resolution

Client could not start. 
Unable to load 
presentation widgets.

The Administration Client 
applet could not start 
because it could not load 
the presentation widgets.

Make sure the image 
directory is available and 
contains .gui and .gif files.

Host name contains illegal 
characters: \ / { ' " or Esc.

Your host name has illegal 
characters.

Do not use \ / { ' " or Esc 
when you name your host 
machine.

Host name exceeds 
maximum length of 20 
characters.

The host machine name is 
too long. The maximum is 
20 characters.

Give your host machine a 
shorter name.



Administration Client error messages

Issue 1.0 August, 2002 49

Internal parameter syntax 
error. Client and server 
are out of sync. Contact 
your support organization.

Administration parameter 
validation failed due to a 
syntax error. The 
Administration Client and 
the server are out of sync.

Contact your support 
organization.

Mandatory entry was left 
blank. Please enter a value 
in field: field name.

You skipped a mandatory 
data entry field.

Go back and enter a valid 
entry on the mandatory 
field.

Paste failed. The clipboard 
may be empty or a type 
mismatch occurred. Make 
sure non-numeric 
characters aren't being 
pasted into a field 
allowing only numeric 
values.

Your paste attempt failed. Try again.

This request is 
inconsistent with the 
server database. Please 
refresh and try again.

Operational Analyst allows 
multiple Administration 
Clients to connect to the 
server simultaneously but 
does not automatically 
update the administration 
data.
Someone else has changed 
the configuration settings 
and your Administration 
Client is not reflecting the 
latest administration data.

Refresh your 
administration screen by 
clicking View > Refresh on 
the Administration Client 
menu.
For more details, see Client 
not updated on page 14.

Unknown error received 
from server, error index 
number: xxxxx

The Administration Client 
and the administration 
server components are out 
of sync.

Try again, if problem 
persists, contact Avaya 
customer support.

Error Message Description Resolution
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Interface Services

Error Message Description Resolution

A service can't be found. 
Please refresh the screen 
and try again.

The Administration Client 
could not find the service.

Refresh your administration 
screen by clicking View > 
Refresh on the 
Administration Client menu.

An error occurred 
obtaining data from 
server. Please try again 
later.

The Administration Client 
encountered an error while 
retrieving data from the 
server.

Try again later.

Host could not be 
contacted.

The Administration Client 
could not reach the host 
machine of the interface 
service

Make sure that the server 
where the interface service 
resides in is not down.

Initialization server could 
not be contacted.

InitSrv process couldn't be 
contacted.

Try again later.

Internal server error or 
client and server are out 
of sync. Contact your 
support organization.

Either an internal server 
error occurred or the 
Administration Client and the 
server are out of sync. The 
asynchronism is most likely 
caused by differing client 
and server software 
versions.

Upgrade the software 
version in your client or 
server.

One or more changes 
failed. Ready.

One or more changes failed 
on the server.

Try again later.

Server connection has 
been lost due to an 
ORBacus failure.

CORBA failure occurred 
during initialization.

Contact Avaya customer 
support.

Services of this type 
cannot be modified. 
Changes to this service's 
configuration are 
equivalent to a delete.

You can not modify 
recorders.

Do not attempt to modify 
recorders.
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Retention Periods

The client encountered 
network failure. Please 
try this operation again 
later.

Network error. Contact your support 
organization.

This <interface service 
type> could not be 
disabled. Unable to 
contact Initialization 
Server.

The Administration Client 
could not disable the 
interface service because it 
could not reach the InitSrv 
process.

Try again later.

Unknown error received 
from server, error index 
number: xxxxx

The Administration Client 
and the administration 
server components are out 
of sync.

Try again. If the problem 
persists, contact Avaya 
customer support.

Error Message Description Resolution

Error Message Description Resolution

Internal server error or 
client and server are out 
of sync. Contact support.

Either an internal server 
error occurred or the 
Administration Client and 
the server are out of sync. 
The asynchronism is most 
likely caused by differing 
client and server software 
versions.

Upgrade the software 
version in your client or 
server.

The historical subsystem 
must be administered to 
access this page.

You need to configure the 
historical subsystem first 
before you can do anything 
with this administration 
screen.

Add a historical subsystem.

Unknown error received 
from server, error index 
number: xxxxx

The Administration Client 
and the administration 
server components are out 
of sync.

Try again. If the problem 
persists, contact Avaya 
customer support.
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Scheduled Jobs

Schemas

Error Message Description Resolution

Can't aggregate data 
prior to the container 
creation date.

You entered an invalid date 
range. Operational Analyst 
cannot aggregate data that 
does not exist.

Enter a valid date range.

Job name contains 
illegal character: \ / { ' " 
or Esc.

Your scheduled job name 
has illegal characters.

Do not use \ / { ' " or Esc 
when you name your host 
machine.

Scheduled job name 
exceeds maximum 
length of 40 characters.

The scheduled job name is 
too long. The maximum is 
40 characters.

Give your scheduled job a 
shorter name.

The Recurrence 
specifies date which do 
not exist.

You may not configure an 
external job to recur every 
30 if your recurrence cycle 
includes February, which 
does not have 30 days.

You must enter a valid day 
for the months.

Error Message Description Resolution

A schema field can't be 
found. Please refresh 
the screen and try again.

The Administration Client is 
not synchronized with the 
server.

Refresh your administration 
screen by clicking View > 
Refresh on the 
Administration Client menu.

An error occurred 
validating the schema 
change request. Please 
try the change again. 
Contact your support 
organization if the 
problem persists.

Operational Analyst could 
not validate the schema 
change requests.

Try your request again later. 
If the problem persists, 
contact your support 
organization.
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Custom schema field 
name is not unique.

The custom schema field 
name is not unique.

Enter a unique name.

Execution date and time 
are not in the future.

You have entered a date 
and time that has already 
transpired, that is, the time 
you specified is in the past.

Since time travel is out of the 
question, you should enter a 
future date.

Inconsistent data found 
in data schema tables. 
Contact your support 
organization.

The data schema tables are 
inconsistent. Your tables 
might contain data types 
that Operational Analyst 
does not support.

Contact your database 
administrator.
If you are the database 
administrator, investigate 
your database and refer to 
the database vendor's 
documentation.

Internal server error 
occurred for data 
schema request. 
Contact your support 
organization.

You have an internal server 
error.

Contact your support 
organization.

Internal server error or 
client and server are out 
of sync. Contact your 
support organization.

You either have an internal 
server error or the 
Administration Client and 
the server are out of sync. 
The asynchronism is most 
likely caused by differing 
client and server software 
versions.

Upgrade the software 
version in your client or 
server.

Internal parameter 
syntax error: client and 
server are out of sync. 
Contact your support 
organization.

The Administration Client 
parameter validation failed 
due to a syntax error.

Contact your support 
organization.

Invalid date field entry 
for: <field name>. Please 
enter time as mm-dd-
yyyy.

You did not enter a valid 
date format.

You must use the mm-dd-
yyyy format. The month and 
the day must have two 
digits, and the year must 
have four. July 4, 2001 
should be entered as 
07/04/2001.

Error Message Description Resolution
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Invalid time field entry 
for: <field name>. Please 
enter time as hh:mm.

You did not enter a valid 
time format.

You must use the hh:mm 
format. You must use two 
digits for the hour and the 
minutes. 3:02 a.m. must be 
entered as 03:02.

More than one schema 
field is selected. Please 
select one schema field 
and try again.

You tried to select two 
schemas.

Modify only one field at a 
time.

Numeric field contains 
non-numeric 
character(s).

You have entered 
characters that are 
inconsistent with the field 
data type, that is you 
entered non-numeric 
characters.

Remove the non-numeric 
characters and enter valid 
characters. Enter numbers 
only.

Only custom fields in the 
Available Fields table 
can be deleted.

You are trying to delete a 
field that is required. It can 
not be deleted.

You just can not delete that 
field.

Request failed. There 
isn't enough disk space 
to complete associated 
migration.

You do not have sufficient 
disk space to accommodate 
the new schema. The 
migration can not be 
completed because of this 
limitation.

Be less ambitious with your 
additions or increase your 
disk space

Required schema fields 
can't be modified.

You can not modify 
required schema fields.

You just have to leave the 
field alone.

Server couldn't get 
required resources. 
Please try again later.

The Administration Client 
and the server may be out 
of sync. Or the server 
components may not be 
able to get needed 
resources, such as logging 
components.

Try again later. If this 
problem persists, contact 
your support organization.
See also General 
Administration Client 
Issues on page 14.

Error Message Description Resolution
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The default time is not 
correct. Please enter 
time as hh:mm:ss.

Time was entered 
incorrectly.

You must use the hh:mm:ss 
format. You must use two 
digits for the hour minutes, 
and seconds. 3:02:05 a.m. 
must be entered as 
03:02:05.

The default value is not 
within the specified 
precision.

You have entered a default 
value that is not within the 
precision.

Enter a value that is within 
the specified precision.

The following schema 
field name is not unique:

Another field has the 
specified name.

Give this field name a 
different name.

This request is 
inconsistent with the 
server database. Please 
refresh and try again.

Operational Analyst allows 
multiple Administration 
Clients to connect to the 
server simultaneously but 
does not automatically 
update the administration 
data.
Someone else has changed 
the configuration settings 
and your Administration 
Client is not reflecting the 
latest administration data.

Refresh your administration 
screen by clicking View > 
Refresh on the 
Administration Client menu.
For more details, see Client 
not updated.

Unknown error received 
from server, error index 
number: xxxxx

The Administration Client 
and the administration 
server components are out 
of sync.

Try again, if problem 
persists, contact Avaya 
customer support.

Error Message Description Resolution
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Subsystems

Error Message Description Resolution

A non-unique site id has 
been specified: nnn

The site ID you entered is 
not unique.

You must have a unique site 
ID.

An invalid IP Address 
was specified. Please 
enter an address in the 
format: n.n.n.n, where 
each n is from 0 to 255.

You entered an invalid IP 
address.

Enter an IP address in a 
format n.n.n.n format, where 
each �n� is a value from 0-
255.

Client and server out of 
sync of server 
components can't be 
accessed. Contact your 
support organization.

The Administration Client 
and the server are not in 
sync. This is most likely 
caused by differing client 
and server software 
versions.

Upgrade the software version 
in your client or server.

Corrupt data has been 
found in the database for 
the historical subsystem.

There is invalid data in 
your database. This could 
occur if someone manually 
alters the database.

Check to see if someone 
altered the database and if 
so, investigate the first day of 
week, first hour of day and 
the archive operations. 
Reverse the changes.

Database contains 
corrupt subsystem 
information. Contact 
your support 
organization.

The database has no 
information about the 
subsystem, the historical 
subsystem is not in the 
database, or someone 
manually altered the 
database.

Check to see if someone 
altered the database.

Host name contains 
illegal characters: \ / { ' " 
or Esc.

The host name has illegal 
characters.

Do not use \ / { ' " or Esc 
when you name your host 
machine.

Internal server error or 
client and server are out 
of sync. Contact your 
support organization.

The Administration Client 
and the server are not in 
sync. This is most likely 
caused by differing client 
and server software 
versions.

Upgrade the software version 
in your client or server.
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IP Address could not be 
derived from Host Name. 
Please enter a valid Host 
Name or IP Address.

Operational Analyst could 
not look up the IP address 
using the provided host 
name. You have either 
provided a non-existent 
host name or your host 
does not have a 
DNS/hosts entry.

Enter a valid host name.

Server connection has 
been lost due to a 
CORBA failure. Please 
reconnect.

CORBA failure occurred 
during initialization.

Reconnect to the server by 
clicking File > Reconnect in 
the Administration Client 
menu bar.

The following subsystem 
could not be deleted, one 
or more containers 
include its site id: xxxxx

Operational Analyst 
cannot delete the event 
subsystem because it still 
contains containers.

You must delete the 
containers first before you 
can remove the subsystem.

The following subsystem 
name is not unique: 
xxxxx

You have entered a 
subsystem name that 
already exists.

Enter a different name.

The historical subsystem 
can not be deleted.

You can not delete the 
historical subsystem.

Do not try to delete the 
historical subsystem.

Unable to lock the 
database tables needed 
to make this change. 
Please try again later.

Someone else is working 
on the database. The 
tables are locked and 
unavailable.

Try again later.

Unknown error received 
from server, error index 
number: xxxxx

The Administration Client 
and the administration 
server components are out 
of sync.

Try again. If the problem 
persists, contact Avaya 
customer support.

Error Message Description Resolution
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Chapter 3: OA Basic Reports

This chapter presents information about Basic Reports operation and the sources that 
provide the data Basic Reports utilize. The information in this chapter is designed to help 
you identify possible Basic Report trouble situations and associated corrective actions, and 
to provide you with details about the various database elements involved in the 
calculations required by each report.

If you desire higher-level descriptions of Basic Report calculations or behavior, refer to the 
Calculations and data formats section in the Basic Reports chapter of Avaya Reporting 
Tools Guide

The main topics in this chapter are:

Historical report size limit

Trouble situations and solutions

Report calculations
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Historical report size limit
By default, historical reports (including Work Item Detail) return no more than 500 rows. 
This limit is imposed to prevent extremely large query jobs reports that could immobilize 
the report and historical database servers.

If a historical report reaches the 500 row limit, an information page is displayed requesting 
that the input criteria be adjusted to reduce the number of rows returned. In certain 
circumstances, the 500 limit may be too low.

To increase the row limit:

1. Edit $OADIR/stumbras/webapp/WEB-INF/ 
config/Reports/DBTypeInfo/DBTypeInfo.properties.

Note:
Avoid using a file editor such as Windows Notepad that can corrupt the file 
content by changing the encoding format. Use an editor that guarantees the 
UTF-8 encoding format.

2. Set ID_MAX_ROWNUM to a value greater than 500.

3. Save the file.

4. Restart the Stumbras service for the change to take effect.

Note:
Changing this limit can affect report and database server performance.
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Trouble situations and solutions
Basic Reports depends on many Operational Analyst components and services being 
present, correctly administered (configured), and running. The table below describes 
several possible trouble situations and actions you can take to resolve the problems.

Problem Possible Cause Solution

An error is displayed 
when clicking the 
localhost/reports 
link.

Services not running. � Verify the www publishing service 
is running and automatic.

� If you restarted the service, then 
restart the Data Manager from a 
command prompt: 

pa disable dm

pa enable dm

� Verify the network is functional.
� Verify the Report Framework 

subsystem is administered and 
running.

� Verify Data Manager is 
administered and running.

Refer to the Operational Analyst 
Administration Client Online Help for 
information about how to verify the 
status of the services and 
subsystems.

Basic reports do not 
run on a report client.

1. Report client files 
are not installed.
2. Insufficient swap 
space.

1. Install the report client files by 
clicking Install Reporting Support 
Files in the tree-view.
2. Be sure to configure at least 700 
MB of swap space on the reporting 
server and each client running 
reports.

Report client installer 
does not launch. The 
error message may 
indicate JVM is not 
found.

JRE is not installed 
on the report client 
machine.

1. Install the correct JRE by clicking 
on Install Reporting Support Files 
in the tree-view.
2. Install the report client files.
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Basic reports do not 
run after an upgrade.

The correct report 
client files are not 
installed.

1. Uninstall the current report client 
files by executing C:\ Program 
Files\Avaya\BI\_uninst\uninstall.jar.
2. Install the report client files by 
clicking Install Reporting Support 
Files in the tree-view.

Table-based basic 
reports run, but no 
graphical reports run.

Report client is not 
installed.

Download the client installation 
program from the tree-view, and 
install the client.

Report client is 
installed, but the applet 
is gray and no 
graphical reports 
appear.

Missing or 
incompatible Java 
Runtime Environment 
(JRE) or Java plug-in 
version.

Download and install JRE patch from 
http://java.sun.com, or uninstall the 
current JRE or Java plug-in and 
launch the applet. This prompts you to 
download the correct plug-in. 
Alternatively, install the JRE on the 
report client machine from the 
installation CD.

Cannot run reports for 
multiple servers.

The same Internet 
Explorer session is 
pointing to multiple 
report servers. This is 
a Java limitation.

Launch a new Internet Explorer 
session for each report server by 
selecting the IE desktop icon or 
through the Start > Programs menu.

Date-time information 
does not reflect my 
time zone.

User�s time zone 
setting is incorrectly 
specified. (Each user 
must do this.)

1. Select User Settings from the tree-
view.
2. Select the desired time zone from 
the menu.
3. Select Save to permanently set the 
time zone.

Negative duration 
values appear in any 
real-time reports.

IC and OA server 
clocks are not 
synchronized.

Follow the instructions in the Time 
Synchronization section of the 
Platform Requirements chapter of 
Avaya Operational Analyst Release 
6.0 Installation and Maintenance 
Guide to set server clock 
synchronization.

Problem Possible Cause Solution

http://java.sun.com
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Aggregation selection 
box is empty on 
historical report input 
pages.

No containers 
defined.

Verify that containers are properly 
administered and enabled.
Allow time for new data to aggregate.
Refer to the Operational Analyst 
Administration Client Online Help for 
details about administering containers 
and scheduling jobs.

Graphical reports 
response is slow or 
reports do not appear.

Temporary 
directories are full.

As reports are accessed, associated 
Java JAR files are copied to the C:\ 
temp or C:\ winnt\temp directories. 
These files are not removed 
programmatically, and over time can 
consume a significant amount of 
memory. Delete these files on a 
regular basis to eliminate this 
problem.

Unable to run graphical 
reports, but table-
based reports do run.

Video card and/or the 
assicated driver do 
not support OpenGL 
acceleration.

Upgrade your video card or video 
driver to the latest version supporting 
OpenGL acceleration.

Either a Dr. Watson 
error appears or 
Internet Explorer 
displays an error 
message, then the 
associated window is 
killed.

Video card and/or 
associated driver are 
incompatible with the 
graphics library 
(Visual Insights) used 
by Basic Reports.

1. Verify that the graphics card and its 
driver meet the OpenGL capability 
requirement specified in the Client 
hardware and software requirements 
section of the Platform requirements 
chapter in the Avaya Operational 
Analyst Release 6.0 Installation and 
Maintenance Guide.
2. Upgrade the video driver to the 
newest version available.
Refer to the release letter on the 
distribution CD for information about 
compatible drivers and updating your 
video driver.

Problem Possible Cause Solution
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Stumbras is running, 
but all reports show 
�Null 
PointerExceptions.�

Communication 
between the Admin 
Manager and 
Stumbras may be 
down, resulting in 
missing database 
configuration 
information.

1. Run the diag command to verify 
the communications link from the 
report server. See The CORBA 
interface on page 145 for more 
information.
2. Review the 
ConfigService.properties file in 
$OADIR/Stumbras/webapp/
WEB-INF/config/ConfigService for 
configuration information. If this file 
does not exist, the report server and 
the Admin Manager are not 
communicating.

Problem Possible Cause Solution
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No Agent data in 
reports or some Agent 
data is missing

Agents are not 
properly configured 
with the role of 
�Agent� in IC 
Manager.

Verify that the role of Agent is 
selected in the agent's Security tab 
properties in the IC Manager.

Agent not 
administered for the 
correct domain in IC 
Manager.

Verify that the domain specified in the 
agent�s General tab is a domain that 
contains an OA Event Collector for the 
OA real-time system where the 
reports are being run.

IC Agent ADU 
servers are not 
running.

Verify the status the IC agent domain 
ADU servers. They should be up and 
running.

IC Agent ADU 
failover strategy is 
not correct.

Verify the IC system failover strategy 
for agent domain ADUs. The agent 
ADU server for the agent data in 
question may have failed over to an 
ADU server in another domain. Agent 
ADU servers must not be allowed to 
failover to ADU servers in domains 
that are not monitored by OA Event 
Collectors.

The agent may have 
failed over to an 
agent ADU domain 
that feeds a different 
OA Event Collector.

Verify that the agents in question have 
not failed over to another agent ADU 
domain. If multiple Event Collectors 
and OA real-time systems are 
configured, the agent's data may be 
appearing on a different OA real-time 
system's report.

Problem Possible Cause Solution
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Report calculations
This section presents the database items used in the calculations for the Basic Reports. If 
you are interested in a more high-level discussion of the generic values used in the 
calculations, please see the Calculations and data formats section in the Basic Reports 
chapter of Avaya Reporting Tools Guide. The reports represented here are:

� Agent Performance - Historical

� Agent Performance - Historical - CMS Version

� Agent Performance - Real-time

� Agent Performance by Service Class and Queue - Historical

� Agent Performance by Service Class and Queue - Real-time

� Agent Performance by Skill - Historical

� Agent Time in State - Real-time

� Service Class and Queue Performance - Historical

� Service Class and Queue Performance - Real-time

� Service Class and Queue Status - Real-time

� Service Class and Queue Volume - Historical

� Skill Performance - Historical

� Work Item Detail

Agent Performance - Historical
The OA database items used to determine administered agents for the input screen are:

The OA database items and calculations used to populate the report floor are:

Input parameter Database table Database item

Agents AgentInfo AgentName (<AgentLogin>)
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The OA database items and calculations used to populate the left and right walls are:

Statistic Database table Database item or calculation

Number of Work Items 
Completed 

AgentSvcClass WkForwardedCnt

Number of Work Items 
Opened 

AgentSvcClass WkOpenedCnt

Average Work Duration AgentSvcClass (WkWorkDur summed across all records 
in AgentSvcClass for this agent) / 
(WkForwardedCnt summed across all 
records in AgentSvcClass for this agent)

Average Wrap-Up 
Duration

AgentSvcClass (WkWrapUpDur summed across all 
records in AgentSvcClass for this agent) 
/ (WkForwardedCnt summed across all 
records in AgentSvcClass for this agent)

Floor statistic Database item or calculation

� Number of Work 
Items Forwarded

� Number of Work 
Items Opened

When the selected statistic for the wall is Total of Floor Data:
(b1+ b2+ b3+ �+ bn) where b = the value a floor column for 
this service class or queue, and where n = the number of 
columns on the floor for this service class/queue or date as 
appropriate

� Number of Work 
Items Forwarded

� Number of Work 
Items Opened

� Average Work 
Duration

� Average Wrap-Up 
Duration

When the selected statistic for the wall is Average of Floor 
Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = is the 
numerator used to calculate the height of the floor column and 
where b = the denominator used to calculate the height of the 
floor column and where n = the number of columns on the 
floor for this service class/queue or date as appropriate.
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Agent Performance - Historical - CMS Version
The OA database items used to determine administered agents for the input screen are:

The OA database items and calculations used to populate the report floor are:

Input parameter Database table Database item

Agents CMSAgentInfo LogName (LogID)

Statistic Database table Database item or calculation

Number of 
ACD Calls

CmsAgent acdcalls + da_acdcalls summed across all skills for 
this agent

Average ACD 
Duration

CmsAgent (acdtime + da_acdtime) / (acdcalls + da_acdcalls) 
the numerator and denominator are separately 
summed across all records for this agent

Average ACW 
Duration

CmsAgent (acwtime + da_acwtime) / (acdcalls + da_acdcalls) 
the numerator and denominator are separately 
summed across all records for this agent
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The OA database items and calculations used to populate the left and right walls are:

Agent Performance - Real-time
The OA database items used to determine administered agents for the input screen are:

The OA database items and calculations used to populate the report floor are:

Floor statistic Database item or calculation

Number of ACD Calls When the selected statistic for the wall is Total of Floor 
Data:
(b1+ b2+ b3+ �+ bn) where b = the value a floor column 
for this Skill, and where n = the number of columns on 
the floor for this Skill or date as appropriate

� Number of ACD Calls
� Average ACD Duration
� Average ACW Duration

When the selected statistic for the wall is Average of 
Floor Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = is 
the numerator used to calculate the height of the floor 
column and where b = the denominator used to calculate 
the height of the floor column and where n = the number 
of columns on the floor for this Skill or date as 
appropriate.

Input parameter Database table Database item

Agents AgentState AgentName (<AgentLogin>)
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The data base items used to determine the contents of the screen tip are:

Statistic Database 
table

Database item or calculation

Number of 
Work Items 
Open

AgentState WkOpenCnt

Average Work 
Duration

AgentSvcClass (WkWorkDur summed across all records in 
AgentSvcClass for this agent) / (WkForwardedCnt 
summed across all records in AgentSvcClass for 
this agent)

Average Wrap-
Up Duration

AgentSvcClass (WkWrapUpDur summed across all records in 
AgentSvcClass for this agent) / (WkForwardedCnt 
summed across all records in AgentSvcClass for 
this agent)

Idle Available 
Duration

AgentState If AgentState = Idle and Availability = Available, 
then Idle Available Duration = IdleAvailDur 
+((Current_Time_of_Day) �
MAX(AgentState.StateStartTime, start of current 
base interval))
else
Idle Available Duration = IdleAvailDur

On Break 
Duration

AgentState If AgentState = On Break, then On Break Duration 
= OnBreakDur +((Current_Time_of_Day) �
MAX(AgentState.StateStartTime, start of current 
base interval))
else
On Break Duration = OnBreakDur

Screen tip label 
text

Database table Database item or calculation

Agent AgentState AgentName

name of statistic 
being displayed

N/A Value of respective column.
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Agent Performance by Service Class and Queue - Historical
The OA database items used to determine the entities on the report floor are:

Agent State AgentState AgentStateName

Current 
Channel Type

AgentState
SvcClassQualInfo
QualCategoryInfo
QualChoiceInfo

QualChoiceInfo.ChoiceName
where: 
AgentState.SvcClassID = 
SvcClassQualInfo.SvcClassID and
SvcClassQualInfo.CategoryID = 
QualCategoryInfo.CategoryID and
QualCategoryInfo.Qualifier = �_Channel� and
QualCategoryInfo.CategoryID = 
QualChoiceInfo.CategoryID and
QualChoiceInfo.ChoiceID = 
SvcClassQualInfo.ChoiceID 

Screen tip label 
text

Database table Database item or calculation

Statistic Database table Database item or calculation

Average Work Duration AgentSvcClass WkWorkDur / WkForwardedCnt 

Average Wrap-Up Duration AgentSvcClass WkWrapUpDur / WkForwardedCnt 

Number of Work Items 
Opened

AgentSvcClass WkOpenedCnt

Number of Work Items 
Completed

AgentSvcClass WkForwardedCnt

Average Customer Hold 
Duration

AgentSvcClass CustomerHeldDur  / 
CustomerHeldCnt

Average Deferred Duration AgentSvcClass WkHeldDur  /  WkHeldCnt
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The OA database items used to determine drop-down box values for the report input 
screen are:

The OA database items used to determine the entities on the report floor are:

Input parameter Database table Database item

Agent(s) Agent Info AgentName (<AgentLogin>)

Service Class(es) 
and/or Queue(s)

SvcClassState SvcClassName (<Data Source Name>)

Statistic Database table Database item or calculation

Average Work Duration AgentSvcClass WkWorkDur / WkForwardedCnt 

Average Wrap-Up Duration AgentSvcClass WkWrapUpDur / WkForwardedCnt 

Number of Work Items 
Opened

AgentSvcClass WkOpenedCnt

Number of Work Items 
Completed

AgentSvcClass WkForwardedCnt

Average Customer Hold 
Duration

AgentSvcClass CustomerHeldDur  / 
CustomerHeldCnt

Average Deferred Duration AgentSvcClass WkHeldDur  /  WkHeldCnt
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The OA database items and calculations used to populate the left and right walls are:

Agent Performance by Service Class and Queue - Real-time
The OA database items used to determine drop-down box values for the input screen are:

The OA database items used to determine the entities on the report floor are:

Floor statistic Database item or calculation

� Number of Work Items 
Opened

� Number of Work Items 
Completed 

When the selected statistic for the wall is Total of 
Floor Data:
(b1+ b2+ b3+ �+ bn) where b = the value of a floor 
column for this service class/queue/agent/date, and 
where n = the number of columns on the floor for 
this service class/queue/agent or date as 
appropriate

� Average Work Duration 
� Average Wrap-Up Duration
� Number of Work Items 

Opened
� Number of Work Items 

Completed
� Average Customer Hold 

Duration
� Average Deferred Duration

When the selected statistic for the wall is Average 
of Floor Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = 
is the numerator used to calculate the height of the 
floor column and where b = the denominator used 
to calculate the height of the floor column and 
where n = the number of columns on the floor for 
this service class/queue/agent or date as 
appropriate

Input parameter Database table Database item

Agents Agent State AgentName (AgentLogin)

Service Classes and 
Queues

SvcClassInfo SvcClassName (<Data Source Name>)
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Statistic Database table Database item or calculation

Average Work Duration AgentSvcClass WkWorkDur / WkForwardedCnt 

Average Wrap-Up 
Duration

AgentSvcClass WkWrapUpDur / WkForwardedCnt 

Number of Work Items 
Opened

AgentSvcClass WkOpenedCnt

Number of Work Items 
Completed

AgentSvcClass WkForwardedCnt

Average Customer 
Hold Duration

AgentSvcClass CustomerHeldDur  / CustomerHeldCnt

Average Deferred 
Duration

AgentSvcClass WkHeldDur  /  WkHeldCnt

For Service Classes:
<Column Color>

AgentCapSetInfo Map AgentRole for this AgentLogin and 
SvcClassID to the specified color for this 
role.
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The OA database items and calculations used to populate the left and right walls are:

Agent Performance by Skill - Historical
The OA database items used to determine drop-down box values for the input screen are:

The OA database items and calculations used to populate the report floor are:

Floor Statistic Data Base Item or Calculation

� Number of Work Items 
Opened

� Number of Work Items 
Completed 

When the selected statistic for the wall is Total of 
Floor Data:
(b1+ b2+ b3+ �+ bn) where b = the value a floor 
column for this service class or queue, and where 
n = the number of columns on the floor for this 
service class/queue or agent as appropriate.

� Average Work Duration
� Average Wrap-Up 

Duration
� Number of Work Items 

Opened
� Number of Work Items 

Completed
� Average Customer Hold 

Duration
� Average Deferred 

Duration

When the selected statistic for the wall is Average 
of Floor Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c 
= is the numerator used to calculate the height of 
the floor column and where b = the denominator 
used to calculate the height of the floor column and 
where n = the number of columns on the floor for 
this service class/queue or agent as appropriate.

Input parameter Database table Database item

Agents CmsAgentInfo LogName (CmsAgentInfo.logid)

Skills CmsSkillInfo SplitName (<Data Source Name>)
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The OA database items and calculations used to populate the left and right walls are:

Agent Time in State - Real-time
The OA database items used to determine the content of drop-down boxes are:

Statistic Database table Database item or calculation

Number of ACD Calls CmsAgent acdcalls + da_acdcalls

Average ACD Duration CmsAgent (acdtime + da_acdtime) / (acdcalls 
+ da_acdcalls)

Average ACW Duration CmsAgent (acwtime + da_acwtime) / (acdcalls 
+ da_acdcalls)

Floor statistic Database item or calculation

Number of ACD Calls When the selected statistic for the wall is Total of 
Floor Data:
(b1+ b2+ b3+ �+ bn) where b = the value a floor 
column for this Skill, and where n = the number of 
columns on the floor for this Skill/agent or date as 
appropriate.

� Number of ACD Calls
� Average ACD Duration
� Average ACW Duration

When the selected statistic for the wall is Average of 
Floor Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = is 
the numerator used to calculate the height of the floor 
column and where b = the denominator used to 
calculate the height of the floor column and where n = 
the number of columns on the floor for this Skill/Agent 
or date as appropriate.
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The OA database items and calculations used to populate the Agent Time in State table 
are:

Drop-down box Database table Database item or calculation

Agents AgentState AgentName (<AgentLogin>)

Agent States N/A � Busy This Service Class or Queue
� Busy Other Service Class or Queue
� Idle
� On Break

Service Classes and 
Queues

SvcClassState SvcClassName

Visual 
representation

Database table Database value or calculation

Number of Agents 
Found

The number of records that comprise the 
table

Agent AgentState AgentName

State (displayed only 
if multiple states are 
selected or if either of 
the �Busy� states is 
selected)

AgentState AgentStateName

Time in State AgentState Now � StateStartTime
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Service Class and Queue Performance - Historical
The OA database items used to determine drop-down box items for the input screen are:

The OA database items and calculations used to populate the report floor are:

Service Class or 
Queue (displayed 
only if multiple service 
classes and/or 
queues are selected 
or if the state Busy 
Other Service Class 
or Queue has been 
selected)

AgentState
SvcClassState

Display SvcClassState.SvcClassName 
where AgentState.SvcClassID = 
SvcClassState.SvcClassID

Role (displayed only 
if a single service 
class is selected. Not 
displayed if multiple 
service classes 
and/or queues are 
selected nor if a 
single queue is 
selected)

AgentState
AgentCapSetInfo
StaticNameInfo

Display StaticNameInfo.DisplayName 
where StaticNameInfo.IDType = 
�AgentRole� and where StaticNameInfo.ID 
= AgentCapSetInfo.AgentRole 
(where AgentState.AgentLogin = 
AgentCapSetInfo.AgentLogin and <the ID 
of the selected service class> = 
AgentCapSetInfo.SvcClassID)
If there is no record in AgentCapSetInfo for 
this combination of AgentLogin and 
SvcClassID, display Blank 
Exception: the Not Administered and 
Unknown roles always appear in the table 
as long as the other input parameters are 
met.

Visual 
representation

Database table Database value or calculation

Input parameter Database table Database Item

Service Classes and 
Queues

SvcClassInfo SvcClassName (<Data Source Name>)
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The OA database items and calculations used to populate the left and right walls are:

Statistic 
selected

Database table Database item or calculation

Percentage of 
Work Items 
Handled Within 
Service Level

SvcClassSummary If UpperThreshold != Null
(WkOpenOnTargetCnt) / (WkOpenOnTargetCnt 
+ WkOpenBehindCnt + WkOpenCriticalCnt + 
WkOpenAheadCnt + WkOpenNoGoalCnt) * 
100%
else
blank

Number of 
Work Items 
Offered

SvcClassSummary WkArrivedCnt

Number of 
Work Items 
Completed

SvcClassSummary WkForwardedCnt

Number of 
Abandoned 
Work Items

SvcClassSummary AbandBehindCnt + AbandOnTargetCnt+ 
AbandNoGoalCnt + AbandAheadCnt + 
AbandCriticalCnt

Average Wait 
Time

SvcClassSummary WkInQueueDur / (WkOpenBehindCnt + 
WkOpenOnTargetCnt  +  WkOpenNoGoalCnt + 
WkOpenCriticalCnt + WkOpenAheadCnt)

Average Time 
to Abandon

SvcClassSummary AbandDur / (AbandBehindCnt + 
AbandOnTargetCnt + AbandNoGoalCnt + 
AbandAheadCnt + AbandCriticalCnt)
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Service Class and Queue Performance - Real-time
The OA database items used to determine drop-down box items for the input screen are:

The OA database items and calculations used to populate the report floor are:

Floor statistic Database item or calculation

� Number of Work Items 
Offered

� Number of Work Items 
Completed

� Number of Abandoned 
Work Items

When the selected statistic for the wall is Total of 
Floor Data:
(b1+ b2+ b3+ �+ bn) where b = the value a floor 
column for this service class or queue, and where n 
= the number of columns on the floor for this service 
class/queue or date as appropriate.

� Percentage of Work Items 
Handled Within Service 
Level

� Number of Work Items 
Offered

� Number of Work Items 
Completed

� Number of Abandoned 
Work Items

� Average Wait Time
� Average Time to 

Abandon

When the selected statistic for the wall is Average 
of Floor Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = 
is the numerator used to calculate the height of the 
floor column and where b = the denominator used to 
calculate the height of the floor column and where n 
= the number of columns on the floor for this service 
class/queue or date as appropriate.

Input parameter Database table Database item

Service Classes 
and Queues

SvcClassState SvcClassName (<Data Source Name>)
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Statistic Database table Database item or calculation

Percentage of Work 
Items Handled 
Within Service Level

SvcClassSummary If SvcGoalID != "1"
(WkOpenOnTargetCnt) / 
(WkOpenCriticalCnt + 
WkOpenOnTargetCnt + 
WkOpenBehindCnt + 
WkOpenAheadCnt + 
WkOpenNoGoalCnt ) * 100%

else

blank

Number of Work 
Items in Queue

SvcClassState QueueSizeCnt

Number of Work 
Items Offered

SvcClassSummary WkArrivedCnt

Number of Work 
Items Completed

SvcClassSummary WkForwardedCnt
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The OA database items used to determine the content of the screen tip are:

Number of 
Abandoned Work 
Items

SvcClassSummary AbandBehindCnt + AbandOnTargetCnt + 
AbandNoGoalCnt + AbandAheadCnt + 
AbandCriticalCnt

Latest Average Wait 
Time

SvcClassSummary Given that:

X = WkOpenCriticalCnt + 
WkOpenAheadCnt + 
WkOpenBehindCnt + 
WkOpenOnTargetCnt +  
WkOpenNoGoalCnt

And �n� represents the current 
database values and �n-1� 
represents the database values at 
the time of the previous report 
update,

When �n� is the first update of the report 
(i.e., where there is no �n-1�) or where �n� 
is the first update of the report for the 
current interval then:

If X(n) > 0 Then Average Wait Time 
= WkInQueueDur(n)/ X(n)

If X(n) = 0 Then display no column at 
all

And when �n� is not the first update of the 
report (i.e., where there is an �n-1�) then

If X(n) � X(n-1) > 0 Then Average 
Wait Time = [WkInQueueDur(n) � 
WkInQueueDur(n-1)] / [X(n) � X(n-
1)]

If X(n) � X(n-1) = 0 then display no 
column at all

Statistic Database table Database item or calculation
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Service Class and Queue Status - Real-time

The OA database items used to determine drop-down box items for the input screen are:

The OA database items used to determine the content of the label screen tips are:

Screen tip label 
text

Database table Database item or calculation

For Service 
Classes: Service 
Class
For Queues: 
Queue

SvcClassState SvcClassName

For Service 
Classes: Service 
Class State

SvcClassState SvcClassStateName

For Service 
Classes and 
Queues: Channel 
Type

SvcClassState
SvcClassQualInfo
QualCategoryInfo
QualChoiceInfo

QualChoiceInfo.ChoiceName 
where: 
SvcClassState.SvcClassID = 
SvcClassQualInfo.SvcClassID and
SvcClassQualInfo.CategoryID = 
QualCategoryInfo.CategoryID and
QualCategoryInfo.Qualifier = "_Channel" and
QualCategoryInfo.CategoryID = 
QualChoiceInfo.CategoryID and
QualChoiceInfo.ChoiceID = 
SvcClassQualInfo.ChoiceID

name of statistic 
being displayed

N/A Value of respective column.

Input parameter Database table Database item

Service Classes 
and Queues

SvcClassState SvcClassName (<Data Source Name>)
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The OA database items and calculations used to populate the floor are:

Screen tip label text Database table Database item or calculation

For Service Classes: 
Service Class
For Queues: Queue

N/A The label of the associated Service 
Class or Queue

For Service Classes: 
Current State

SvcClassState SvcClassStateName

For Service Classes 
Critical Threshold

SvcClassGoalInfo if CriticalThreshold != NULL then 
CriticalThreshold
else
�None�

For both Service 
Classes and Queues: 
Upper Threshold

SvcClassGoalInfo if UpperThreshold != NULL then 
UpperThreshold
else
�None�

For Service Classes: 
Lower Threshold

SvcClassGoalInfo if LowerThreshold != NULL then 
LowerThreshold
else
�None�
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Statistic Database table Database item or calculation

Number of Work 
Items in Queue

SvcClassState QueueSizeCnt

Service Class 
State

SvcClassState For Advocate-delivered service classes (i.e. 
QueueType = Advocate and EWT != 
NULL):
SvcClassState, where

Unknown = a gap in the ribbon or 
histogram

Agents Available = -3

Queue Empty = -2

Ahead of Target = -1

On Target = 0

Future Risk = 1

Immediate Risk = 2

Behind Target = 3

Critical = 4

 (all numbers are relative to the floor, which 
is at 0)
A ribbon�s or histogram�s color corresponds 
to the current Service Class state. States 
are organized into categories and each 
category is distinguished by its color: 

Red = Critical, 

Yellow = Behind Target,

Green = On Target, Future risk, 
Immediate Risk

Blue = Ahead of Target, Agents 
Available, and Queue empty.

For Non-Advocate-delivered service classes 
and Queues (i.e. EWT = NULL):

display nothing
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Oldest Wait Time SvcClassState Now � OldestArrivalTime

Latest Average 
Wait Time

SvcClassSummary Given that:

X = WkOpenCriticalCnt + 
WkOpenBehindCnt + 
WkOpenOnTargetCnt + 
WkOpenAheadCnt + 
WkOpenNoGoalCnt

And �n� represents the current 
database values and �n-1� represents 
the database values at the time of the 
previous report update,

Then:
When �n� is the first update of the report 
(i.e., where there is no �n-1�) or where �n� is 
the first update of the report for the current 
interval then

If X(n) > 0 Then Average Wait Time = 
WkInQueueDur(n)/ X(n)

If X(n) = 0 Then display a �gap� in the 
ribbon or histogram

And when �n� is not the first update of the 
report (i.e., where there is an �n-1�) then

If X(n) � X(n-1) > 0 Then Average Wait 
Time = [WkInQueueDur(n) � 
WkInQueueDur(n-1)] / [X(n) � X(n-1)]

If X(n) � X(n-1) = 0 then display a 
�gap� in the ribbon or histogram

Statistic Database table Database item or calculation
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The OA database items and calculations used to populate the left wall are:

Statistic Database table Database value or calculation

Number of Work 
Items in Queue

SvcClassState QueueSizeCnt

Expected Wait Time SvcClassState For Service Classes:

If EWT != NULL and EWTUsed = 1 
then

EWT

else

blank

For Queues:

blank

Oldest Wait Time SvcClassState For Queues:

Now � OldestArrivalTime

For Service Classes:

blank

30-Minute Average 
Wait Time

N/A [Current AWT(1) + Current AWT(2) + � 
Current AWT(N)] / N
N = The total number of Current AWT 
values generated over the 30 minute 
period.
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The OA database items and calculations used to populate the right wall are:

Visual 
representation

Database Table.Column Database value or 
calculation

Pie slice size Where AgentCapSetInfo.SvcClassID = the ID 
of the selected service class
<Role> Pie:
and where AgentCapSetInfo.AgentRole = 
<Role> according to the following table:

<State> slice:
and where: 
AgentState.AgentState = <state> according to 
the following table:

Count the number 
of matching 
records

Total that appears 
beneath pie label 
in parenthesis �()�.

N/A The sum of the pie 
slice sizes for a 
pie.

Role Agent Role Values

Regular 0

Reserve 1

Backup 2

State Agent State Values

Idle 3

On break 5

Busy this 
Service 
Class

1 & 2 and 
AgentState.SvcClassID = the 
ID of the selected service class

Busy other 
Service 
Class or 
Queue

1 & 2 and 
AgentState.SvcClassID != the 
ID of the selected service class
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Service Class and Queue Volume - Historical
The OA database items used to determine drop-down box items for the input screen are:

The OA database items and calculations used to populate the floor are:

The OA database items and calculations used to populate the left wall are:

Input parameters Database 
table

Database item

Service Classes and 
Queues

SvcClassInfo SvcClassName (<Data Source Name>)

Statistic Database table Database item or calculation

Work Offered SvcClassSummary WkArrivedCnt

Work 
Completed

SvcClassSummary WkForwardedCnt

Statistic Database table Database value or calculation

Average Wait 
Time

SvcClassSummary For each selected Service Class or Queue
[(a1 + a2 + � an)] / [ (b1 + b2 + � bn)]

where 

a = WkInQueueDur 

b = Sum [WkOpenBehindCnt + 
WkOpenNoGoalCnt + WkOpenOnTargetCnt + 
WkOpenCriticalCnt + WkOpenAheadCnt]

and n = the number of �y� time categories.
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The OA database items used to determine the entities on the right wall are:

Skill Performance - Historical
The OA database items used to determine drop-down box items for the input screen are:

The OA database items and calculations used to populate the report floor are:

Statistic Database table Database value or calculation

Average Wait 
Time

SvcClassSummary For each selected Service Class or Queue
[(a1 + a2 + � an)] / [ (b1 + b2 + � bn)]

where 

a = WkInQueueDur 

b = Sum [WkOpenBehindCnt + 
WkOpenNoGoalCnt + WkOpenOnTargetCnt + 
WkOpenCriticalCnt + WkOpenAheadCnt]

where n = the number of service classes and 
queues on the x-axis.

Input Parameter Database 
Table

Database Item

Skills CmsSkillInfo SplitName (<Data Source Name>)
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The OA database items and calculations used to populate the left and right walls are:

Work Item Detail
The data used to populate the Channels and Agents drop-down boxes on the input page 
are determined as follows:

Statistic Database 
table

Database item or 
calculation

Number of ACD Calls CmsSkill acdcalls

Average Speed of Answer CmsSkill anstime / acdcalls

Number of Abandoned Calls CmsSkill abncalls

Average Time to Abandon CmsSkill abntime / abncalls

Floor Statistic Database Item or Calculation

� Number of ACD Calls
� Number of Abandoned 

Calls

When the selected statistic for the wall is Total of 
Floor Data:
(b1+ b2+ b3+ �+ bn) where b = the value of a floor 
column for this Skill, and where n = the number of 
columns on the floor for this Skill or date, as 
appropriate.

� Number of ACD Calls
� Average Speed of Answer
� Number of Abandoned 

Calls
� Average Time to Abandon

When the selected statistic for the wall is Average of 
Floor Data:
[(c1+c2+c3+�+cn)/ (b1+ b2+ b3+ �+ bn)] where c = is 
the numerator used to calculate the height of the floor 
column, and where b = the denominator used to 
calculate the height of the floor column, and where n = 
the number of columns on the floor for this Skill or date 
as appropriate.
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Input Element Database Table Database Item or Calculation

Channels N/A The following items:
� Voice
� Email
� Text Chat

Agents Employee Display FULLNAME (LOGINNAME)
where ROLE_AGENT = 1
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The OA database items used to determine the records that comprise the Work Item Detail 
report and the content of the report columns are:

:

Report Column Database table Calculation

This record is included 
if the criteria in the 
calculation column are 
met. The value 
displayed in the Date 
column is the value 
contained in the 
associated Contact 
field.

Contact If Contact.CreateTime is within the date 
range selected in the Date Range 
portion of the input page
Then display
Contact.CreateTime

If the From text box is 
populated then this 
record is included if the 
criteria in the 
calculation column are 
met

Contact
MediaInteraction

If Selected Channels includes Voice 
then

MediaInteraction.Type = 2 (i.e. 
voice), and MediaInteraction.ANI 
contains value in From box, and 
Contact.VDUID = 
MediaInteraction.Contact_Key

If Selected Channels includes Email 
then

MediaInteraction.Type = 0 (i.e. 
email), and 
MediaInteraction.Sender contains 
value in From box, and 
Contact.VDUID = 
MediaInteraction.Contact_Key

If Selected Channels includes Text Chat 
then

MediaInteraction.Type = 1 (i.e. 
chat), and 
MediaInteraction.UserName 
contains value in From box, and 
Contact.VDUID = 
MediaInteraction.Contact_Key

If the user selects more than one 
channel then these criteria are �OR'd� 
together.
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If the To input box is 
populated then this 
record is included if the 
criteria in the 
calculation column are 
met.

Contact
MediaInteraction

If Selected Channels includes Voice 
then

MediaInteraction.Type = 2 (i.e. 
voice), and MediaInteraction.DNIS 
contains value in To box, and 
Contact.VDUID = 
MediaInteraction.Contact_Key

If Selected Channels includes Email 
then

MediaInteraction.Type = 0 (i.e. 
email), and 
MediaInteraction.Recipient 
contains value in To box, and 
Contact.VDUID = 
MediaInteraction.Contact_Key

If the user selects more than one 
channel then these criteria are �OR'd� 
together.

Report Column Database table Calculation
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If one or more values in 
the Channel drop-
down box are selected 
then this record is 
included if the criteria in 
the calculation column 
are met.

Contact
MediaInteraction

If Selected Channels includes Voice 
then

MediaInteraction.Type = 2 (i.e. 
voice), and Contact.VDUID = 
MediaInteraction.Contact_Key

If Selected Channels includes Email 
then

MediaInteraction.Type = 0 (i.e. 
email), and Contact.VDUID = 
MediaInteraction.Contact_Key

If Selected Channels includes Text Chat 
then

MediaInteraction.Type = 1 (i.e. 
chat), and Contact.VDUID = 
MediaInteraction.Contact_Key

If the user selects more than one 
channel then these criteria are �OR'd� 
together.

If one or more values in 
the Agent drop-down 
box are selected then 
this record is included if 
the criteria in the 
calculation column are 
met.

Contact
RoutingEvent
AgentSegment

If AgentSegment.Employee_Key = the 
selected agent PKEY value and 
Contact.VDUID = 
RoutingEvent.Contact_Key and 
AgentSegment.Segment_Key = 
RoutingEvent.UUID and 
AgentSegment.ParticipationRole = 0 
(i.e., Primary Agent)

Report Column Database table Calculation
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If the value in the Time 
in System drop-down 
boxes is > 0 then this 
record is included if the 
criteria in the 
calculation column are 
met. The value 
displayed in the Time 
in System column is 
the value contained in 
the associated Contact 
field.

Contact If Contact.Duration meets the input 
criterion include this record and display 
Contact.Duration

Report Column Database table Calculation
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If the value in the 
Number of Times 
Handled pull-down box 
is > 0 then this record is 
included if the criteria in 
the calculation column 
are met. The value 
displayed in the 
Number of Times 
Handled column is the 
value contained in the 
associated Contact 
field.

Contact If Contact.Interactions meets the input 
criterion include this record and display 
Contact.Interactions

If the value in the 
Number of Times 
Held or Deferred drop-
down boxes is > 0 then 
this record is included if 
the criteria in the 
calculation column are 
met. The value 
displayed in the 
Number of Times 
Held or Deferred 
column is the value 
contained in the 
associated 
MediaInteraction field.

Contact
RoutingEvent

If Selected Channels includes Voice 
then

RoutingEvent.HoldCount meets the 
input criterion, and Contact.VDUID 
= RoutingEvent.Contact_Key

If Selected Channels includes Email 
then

RoutingEvent.DeferCount meets 
the input criterion, and 
Contact.VDUID = 
RoutingEvent.Contact_Key

If Selected Channels includes Text Chat 
then

RoutingEvent.Web_Defer_Count 
meets the input criterion, and 
Contact.VDUID = 
RoutingEvent.Contact_Key

If the user selects more than one 
channel then these criteria are �OR'd� 
together.

Report Column Database table Calculation
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The OA database items used to determine the content of the Segment Information report 
elements are

:

Report element Database table Database item or calculation

Work Item ID Contact VDUID

Start Time N/A start time of first segment

Agent RoutingEvent
AgentSegment
Employee

CmsCallHistory
CmsAgentInfo

For QRepository records:

If there is a record in AgentSegment 
where AgentSegment.Segment_Key 
= RoutingEvent.UUID then

Employee.FullName where 
Employee.Pkey = 
AgentSegment.Employee_Key, 
and 
AgentSegment.ParticipationRole 
= 0, and 
AgentSegment.Segment_Key = 
RoutingEvent.UUID

else

<blank>

For Call History records:

If CmsCallHistory.AnsLogin = 
<blank>

<blank>

else

CmsAgentInfo.LogName 
whereCmsCallHistory.AnsLogin = 
CmsAgentInfo.LogID and 
CmsCallHistory.SourceID = 
CmsAgentInfo.SourceID
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Queue or Skill RoutingEvent
Queue

CmsCallHistory
CmsSkillInfo

For QRepository records:

Queue.QueueName where 
RoutingEvent.Queue_Key = 
Queue.PKey

For Call History records:

if CmsCallHistory.DispSplit = -1 then

<blank>

else

CmsSkillInfo.SplitName where 
CmsCallHistory.DispSplit = 
CmsSkillInfo.Split and 
CmsCallHistory.SourceID = 
CmsSkillInfo.SourceID

From Media Interaction

CmsCallHistory

For QRepository records:

If MediaInteraction.Type = 2 (i.e., 
voice) then display 
MediaInteraction.ANI

If MediaInteraction.Type = 0 (i.e., 
email) then display 
MediaInteraction.Sender

If MediaInteraction.Type = 1 (i.e., 
chat) then display 
MediaInteraction.UserName

For CallHistory records:

if CmsCallHistory.Calling_Pty != 
NULL then 

display 
CmsCallHistory.Calling_Pty

else

display <blank>

Report element Database table Database item or calculation
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To Media Interaction

CmsCallHistory

For QRepository records:

If MediaInteraction.Type = 2 (i.e., 
voice) then display 
MediaInteraction.DNIS

If MediaInteraction.Type = 0 (i.e., 
email) then display 
MediaInteraction.Recipient

If MediaInteraction.Type = 1 (i.e., 
chat) then display <Blank>

For CallHistory records:

if CmsCallHistory.FirstVdn != NULL 
then 

display CmsCallHistory.FirstVdn

else

display <blank>

Report element Database table Database item or calculation
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Channel MediaInteraction For QRepository records:

If MediaInteraction.Type = 2 (i.e., 
voice) then display �Voice�

If MediaInteraction.Type = 0 (i.e., 
email) then display �Email�

If MediaInteraction.Type = 1 (i.e., 
chat) then display �Text Chat�

For CallHistory records:

�Voice�

Duration RoutingEvent

CmsCallHistory

For QRepository records:

If MediaInteraction.Type = 2 (i.e., 
voice)

RoutingEvent.voicetalktime + 
RoutingEvent.voiceholdtime + 
RoutingEvent.WrapTime

If MediaInteraction.Type = 0 (i.e., 
email)

RoutingEvent.emailwritetime + 
RoutingEvent.emailinacttime + 
RoutingEvent.defertime

If MediaInteraction.Type = 1 (i.e., 
chat)

RoutingEvent.chattalktime + 
RoutingEvent.chatholdtime + 
RoutingEvent.WrapTime 

For Call History records:

CmsCallHistory.AcwTime + 
CmsCallHistory.TalkTime

Report element Database table Database item or calculation
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The OA database items used to determine the content of the Wrap-up Codes report 
elements are:

Report element Database table Database item or calculation

Work Item ID N/A From Work Item ID element of the Segment 
report.

Agent N/A From the Agent column of this segment of 
the Segment report.

Duration N/A From the Duration column of this segment 
of the Segment report.

category codes Contact
RoutingEvent
TaskPerformed
TaskPerformedCode
ClassificationCode

If reached from the Segment Information 
report:

Display ClassificationCode.Name 
where 

TaskPerformed.RoutingEvent_Key = 
RoutingEvent.UUID and 
TaskPerformed.Pkey = 
TaskPerformedCode.TaskPerformed_
Key and ClassificationCode.Pkey = 
TaskPerformedCode.Code_Key and 
ClassificationCode.CodeType = 1 (i.e., 
Category Code)

If reached from the Work Item Detail report:

Display ClassificationCode.Name 
where:

RoutingEvent.Contact_Key = 
Contact.VDUID and 
TaskPerformed.RoutingEvent_Key = 
RoutingEvent.UUID and 
TaskPerformed.Pkey = 
TaskPerformedCode.TaskPerformed_
Key and ClassificationCode.Pkey = 
TaskPerformedCode.Code_Key and 
ClassificationCode.CodeType = 1 (i.e., 
Category Code)



Report calculations

Issue 1.0 August, 2002 103

reason codes Contact
RoutingEvent
TaskPerformed
TaskPerformedCode
ClassificationCode

If reached from the Segment Information 
report:

Display ClassificationCode.Name 
where 

TaskPerformed.RoutingEvent_Key = 
RoutingEvent.UUID and 
TaskPerformed.Pkey = 
TaskPerformedCode.TaskPerformed_
Key and ClassificationCode.Pkey = 
TaskPerformedCode.Code_Key and 
ClassificationCode.CodeType = 3 (i.e., 
Reason Code)

If reached from the Work Item Detail report:

Display ClassificationCode.Name 
where:

RoutingEvent.Contact_Key = 
Contact.VDUID and 
TaskPerformed.RoutingEvent_Key = 
RoutingEvent.UUID and 
TaskPerformed.Pkey = 
TaskPerformedCode.TaskPerformed_
Key and ClassificationCode.Pkey = 
TaskPerformedCode.Code_Key and 
ClassificationCode.CodeType = 3 (i.e., 
Reason Code)

Report element Database table Database item or calculation
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outcome codes Contact
RoutingEvent
TaskPerformed
TaskPerformedCode
ClassificationCode

If reached from the Segment Information 
report:

Display ClassificationCode.Name 
where 

TaskPerformed.RoutingEvent_Key = 
RoutingEvent.UUID and 
TaskPerformed.Pkey = 
TaskPerformedCode.TaskPerformed_
Key and ClassificationCode.Pkey = 
TaskPerformedCode.Code_Key and 
ClassificationCode.CodeType = 2 (i.e., 
Outcome Code)

If reached from the Work Item Detail report:

Display ClassificationCode.Name 
where:

RoutingEvent.Contact_Key = 
Contact.VDUID and 
TaskPerformed.RoutingEvent_Key = 
RoutingEvent.UUID and 
TaskPerformed.Pkey = 
TaskPerformedCode.TaskPerformed_
Key and ClassificationCode.Pkey = 
TaskPerformedCode.Code_Key and 
ClassificationCode.CodeType = 2 (i.e., 
Outcome Code)

Report element Database table Database item or calculation



Issue 1.0 August, 2002 105

Chapter 4: OA Features

This chapter presents monitoring and troubleshooting information about core Operational 
Analyst features. This information will help you determine possible sources of difficulty in 
various portions of Operational Analyst, like historical or real-time databases, OA 
subsystems, and various data and user interfaces. Trace files, alarm messages and error 
messages are valuable tools, and this chapter helps to clarify the information they provide.

The major sections in this chapter are:

� Processes

� Trace files

� Alarm messages

� Error messages

� Forwarders and recorders

� The CORBA interface

� TimesTen database

� Data Manager and Report Data Server

� Event Collector

� Schema migration

� Stumbras
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Processes
Operational Analyst provides two tools to help you monitor its various processes: 
Administration Client and the pa utility. Master Operations Manager (MOM) is the behind-
the-scenes controller of Operational Analyst processes that takes input from either the 
Administration Client or the pa utility. This section provides information about both MOM 
and pa.

Note:
When a reboot occurs on an Operational Analyst system and the OA 
processes are starting up, some processes that depend on the database 
may not start initially because the database itself is not up yet. Master 
Operations Manager attempts to restart these processes 3 times within 5 
minutes, and then repeats the attempts during the next 5 minutes. All 
processes should start successfully during this second 5 minute period 
since the database should be running by then. Two processes that may be 
affected in this manner are sched (scheduler) and admb (Admin Manager 
Base Server).

Master Operations Manager
MOM receives input from an Administration Client graphical user interface or from the 
command line utility pa. From the Administration Client Interface Services screen, you 
can elect to disable or enable the forwarder, data manager, and data server processes on 
an Operational Analyst real-time server, the recorder on an Operational Analyst historical 
server, the forwarder-recorder on a co-resident server (historical and real-time), or disable 
or enable a forwarder on CMS. Using the pa command, you can elect to enable or disable 
these and other Operational Analyst processes, or stop and start all Operational Analyst 
processes.

MOM maintains a list of all processes under MOM control. Upon stopping and re-starting 
the Operational Analyst service (as during a reboot), the MOM remembers which 
processes where disabled and does not restart those processes.

This table shows the processes controlled by the MOM and the respective servers on 
which they run.

Process MOM process ID Operational Analyst server

Historical Real-time Reporting CMS

MOM N/A x x x x

recorder reccmscallhistory x
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reccmssynonyms x

reccmsagent x

reccmsskill x

reccmsvdn x

reccmscwc x

recworkitem x

recdisplaynames x

recagentstate x

recagent x

recservicestate x

recserviceclass x

recprocess x

recivrport x

scheduler schd x

forwarder fwdworkitem x

fwddisplaynames x

fwdagentstate x

fwdagent x

fwdservicestate x

fwdserviceclass x

fwdprocess x

fwdivrport x

fwdcmscallhistory x

fwdcmssynonyms x

fwdcmsagent x

fwdcmsskill x

Process MOM process ID Operational Analyst server

Historical Real-time Reporting CMS
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* Started and stopped via the NT Services panel.

Note:
 The MOM process does not have a process ID as do the other processes. 

The pa utility
The pa utility allows the enabling, starting, and stopping of Operational Analyst processes. 
This interface allows a user with the proper permissions to shut down all processes at once 
or start all Operational Analyst processes. Commands for use of pa are described below. 
Once executed, all commands indicate whether or not they executed successfully.

Enable

You may enable any Operational Analyst process using the pa command line utility. From 
the Administration Client Interface Services screen, you can elect to enable the 
recorder, forwarder, forwarder-recorder, data manager, and data server. Each request to 
enable a process is logged. To enable scheduler, type the following at a command 
prompt:

pa enable schd

fwdcmsvdn x

fwdcmscwc x

application 
management 
server

ams x x x x

security aut x x x x

admin mgr admb x x x x

adm0 x x x x

data manager dm x

data server dsvr x

report 
framework*

x

Process MOM process ID Operational Analyst server

Historical Real-time Reporting CMS
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Disable

You may disable any Operational Analyst process using the pa command line utility. You 
can disable the recorder, forwarder, forwarder-recorder, data manager, and data server, 
from the Administration Client. Each request to disable a process is logged. To disable the 
first administration manager on an historical server, type the following at a command 
prompt:

pa disable adm1

Start

You may request to start all processes. This also starts the MOM. To start all of the 
processes, type the following at a command prompt:

pa start all

Stop 

You may request to stop all processes. This also stops the MOM. Therefore, once 
executed, Administration Client requests to enable individual processes will fail. To stop all 
of the processes, type the following at a command prompt:

pa stop all

Command line options

The pa utility allows the enabling, starting, and stopping of Operational Analyst processes. 
This interface allows a user with the proper permissions to shut down all processes at once 
or start all Operational Analyst processes. Commands for use of pa are described below. 
Once executed, all commands indicate whether or not they executed successfully.
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Note:
The process IDs are the MOM process IDs listed in the table in Master 
Operations Manager on page 106. They are not the operating system 
process ids. 

pa start all

Start the MOM and all the processes. 

pa stop all

Stop the MOM and all the processes.

pa enable processId

Enable a process. 

pa disable processId

Disable a process.

pa active processId

Find out if a process is currently running. 

pa state processId

Display whether the process is enabled or disabled.

pa cat

Display the MOM list of processes and their characteristics as contained in the 
momtab file. This file should not normally be edited. If it is edited, the only field 
that should be changed is the -v 10 field. 

pa list

Display the list of processes activated by the MOM and their current state. 

Other Operational Analyst processes
In addition to the processes described in the previous sections, Operational Analyst is 
dependent upon other process that are not under the control of MOM.

ORBacus Naming Service

The ORBacus Naming Service must be running on all servers. To verify the service is 
running:

� On Windows NT: Settings > Control Panel > Services.

� On Windows 2000: Settings > Control Panel > Administrative Tools > Services.

Look for ORBacus Naming Service and verify that it has a status of Started. If not, 
start it from this Services window.
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� On Solaris: From the command line enter ps -ef|grep namesrv.

If the service is running, a line containing the service name namesrv, UID, GID and other 
information about the service is displayed. If the service is not running a line containing 
only grep namesrv is displayed.

If the service is not running, as root, or with root privileges, edit /etc/inittab to see if 
namesrv is set to respawn. 

� If namesrv is not currently set to respawn:

1. Set namesrv to respawn
2. Write the file

3. Execute init q.

� If namesrv is currently set to respawn:

1. Set namesrv to off.
2. Write the file.

3. Execute init q.

4. Set namesrv to respawn.

5. Write the file.

6. Execute init q again.

TimesTen Database Services

Services associated with the TimesTen database must be running on the real-time server. 
See Starting or stopping TimesTen on page 146 for information on starting TimesTen 
services.

Report Framework Service

The Report Framework Service must be running on the report server. Additionally, 
services associated with the Webserver must be running on the report server. Refer to the 
Webserver documentation for details on Webserver services.

To verify the Report Framework Service is running:

� On Windows NT: Settings > Control Panel > Services.

� On Windows 2000: Settings > Control Panel > Administrative Tools > Services.

Look for Stumbras-Tomcat and verify that it has a status of Started. If not, start it 
from this Services window.

� On Solaris: From the command line enter ps -ef|grep stumbras.
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If the service is running, a line containing the service name strumbras, UID, GID and other 
information about the service is displayed. If the service is not running a line containing 
only grep strumbras is displayed.

If the service is not running, as root, or with root privileges, edit /etc/inittab to see if 
stumbras is set to respawn. 

� If stumbras is not currently set to respawn:

1. Set stumbras to respawn
2. Write the file

3. Execute init q.

� If stumbras is currently set to respawn:

1. Set stumbras to off.
2. Write the file.

3. Execute init q.

4. Set stumbras to respawn.

5. Write the file.

6. Execute init q again.

Database services

Services associated with the historical database must be running on the server containing 
the database. Please refer to the database documentation for details about its particular 
service requirements.
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Trace files 
Trace allows you to isolate and diagnose problems within a process as well as problems 
between communicating processes. 

Note:
Trace files are not intended for customer use, but rather for Avaya Customer 
Support representatives, system verification engineers, or development 
engineers who are engaged in troubleshooting Operational Analyst 
problems.

This section provides information about using trace files.

Loginfo file
The loginfo file contains the trace log parameters used by the Logger to determine the 
name, location, size, and number of rollover files associated with each component. There 
is one loginfo file:

%PABASE%\data\admin\loginfo

It specifies information for Operational Analyst server and the Operational Analyst 
Administration Client.

Following is an example of some entries in this file:

dbchecktrc data/log/dbcheck/dbchecktrc 150000 10

reccmsagent data/log/recorder/cmsagentTrc 500000 3 

The first two items of each entry should not be changed (forward slashes are required). 
The third item specifies the maximum size of the trace file in bytes and can be modified to 
a value of 100,000 to 10,000,000. The fourth item specifies the maximum number of 
rollover files and can be modified to a value of 3 to 99. If you need larger or more log files, 
you can modify these two items. However, if you increase these values, be sure to verify 
that there is enough disk space on the machine before making the changes.

Locating trace files
Most of the trace files are located in the directories in the %PABASE%\data\log directory. 
To locate a particular server trace file, edit the loginfo file described above and find the 
path and filename (the second item in the entry) associated with the process of interest.
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Trace levels
Trace files contain trace information that results from the trace level you set. There are 
three levels of tracing available: Event level (10), Interface level (20), and Debug level (30). 
The Event level tracing provides the least amount of information, Interface level provides 
more detailed trace information, and the Debug level provides the most detailed trace 
information.

Trace levels above Event level (10) produce a large volume of data and should be used 
sparingly, especially the Debug level (30). The large amount of data logged can affect the 
overall performance and throughput of Operational Analyst. 

Note:
If anti-virus software is running on a system where a high level of tracing is 
enabled, performance may be further impacted. This is especially noticed 
when the trace levels are increased for Data Manager and Aggregation. 
While troubleshooting at this level, be sure to configure the anti-virus 
software so that is does not scan the trace files. If the system performance is 
still impaired, you may consider turning off the anti-virus software while 
capturing the trace information needed.

Trace levels can be changed dynamically or statically. Dynamic changes apply only to the 
currently running processes. If the trace level must be maintained on an on-going basis 
even after stopping and restarting a process, the trace level must be changed statically.

Dynamic trace level changes

The Application Management Framework provides the capability to dynamically change 
the tracing level for all of the OA CORBA servers. With this functionality, you do not need 
to stop processes to change the tracing level. Keep in mind that the level that you set is 
only valid as long as the current instance of the process is running. It will be reset to the 
values in MOM if the process restarts. 

The command-line tool syntax is: 

amui [host hostname] process processname tlevel level

where 

� hostname is the IP or DNS name of the host where the CORBA process is running, 
localhost is used if not specified.

� processname is the name of the CORBA process. 

� level is a valid trace level of 0,10,20, or 30.

Note:
For Solaris the command is amui.sh.
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For example:

amui host oalab process recagentstate tlevel 30

sets the trace level of the recagentstate process to the highest debug level.

Static trace level changes

If it becomes necessary to permanently change the tracing level for a process, edit the 
%PABASE%\data\admin\mom\etc\momtab file. This file contains entries for each of the 
processes that MOM controls. The line associated with the process of interest must be 
modified, then the process must be stopped and restarted for the change to take effect

For example, consider this excerpt from a %PABASE%\data\adminmom\etc\momtab 
file:
admb:234:respawn:java com.avaya.cc.cvx.adminmgr.AdminMgrSrv.AdminMgrSrvBaseServer 
-v 10
adm0:234:respawn:java com.avaya.cc.cvx.adminmgr.AdminMgrSrv.AdminMgrSrvServer -i 0 
-v 10
ams:1234:respawn:java com.avaya.cc.cvx.appmanserver.AppManServer -v 0

To permanently increase the trace level for the admb process to the highest debug level, 
change -v 10 to -v 30. Then stop and restart the admb process via the pa command. (See 
The pa utility on page 108 for more information.)

Note:
Do not modify any other values in the momtab file.

Administration Client trace levels

See AdminPol.html on page 24 for details on setting Administration Client trace levels.
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List managed processes
To list the managed CORBA processes, use the following command:

amui [host hostname] list

This displays the list of managed processes running on hostname, or localhost if 
hostname is not specified. These process names can be used to change the tracing level.

Note:
For Solaris the command is amui.sh.
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View load level on host
To view the CPU load level on a host, use the following command:

amui [host hostname] load

With this command, you can display the load level of the CPU on hostname, or on 
localhost if hostname is not specified.

Note:
For Solaris the command is amui.sh.
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Alarm messages
When an alarm occurs, Operational Analyst forwards an alarm message to the IC Alarm 
Server, which is part of the IC Manager. The IC Alarm Server may be on a Windows 
system or a Solaris system. IC alarms are viewed using the IC Alarm Monitor. This viewer 
resides on a client machine and is therefore supported only on Windows systems. The IC 
Alarm Viewer provides a GUI interface to view and clear alarms. It can view the alarms of 
multiple Alarm Servers.

An OA alarm is cleared through software by raising an informational alarm. Cleared alarms 
should clearly state that the specific condition no longer exists.

In addition to being forwarded to an IC Alarm Server, OA alarms are also logged into the 
local OA central error log (the Windows Event Log or the Solaris CentralErrorLog.log 
file), as well as into trace files if tracing is activated.

Note:
In a CMS-only configuration, alarms are logged only in the 
CentralErrorLog.log file and trace files (if tracing is activated) because 
there is no associated IC system to receive the alarm messages.

To view alarms:

On the IC system, from IC Manager select Tools > Alarm Monitor.

Alarm properties
The alarm properties, stored in the %PABASE%\data\admin\server.properties file, 
specify the host type and location of the alarm server to receive the alarms. This file is 
configured during installation, and under normal conditions does not require editing. 
However, if error messages are logged indicating that alarm messages cannot be 
forwarded because of incorrect properties values, edit the file and assure these two entries 
are as follows:

AlarmHostType=IC

AlarmServer=<alarmserver location>

where alarmserver location is the fully qualified IP address of the alarm server that 
is to receive the alarms. (For example: myAlarmServerName.dr.avaya.com.)

Alarm tables
Alarms originate from several Operational Analyst sources. The following tables present 
the alarms from each of the sources. To aid your understanding of the information 
presented in the tables, review these tips:
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� The Alarm message column of the tables shows the message as it appears in the IC 
Alarm Monitor and the error log.

� In some cases in the tables an alarm message has an ellipsis (...) at the end of the text. 
This indicates that the actual alarm message will present more information based on 
where in the product the alarm is generated.

� Some alarm message entries contain a list of strings within square brackets, like 
[ a1 | a2 | a3 ]. This indicates that one of the values in the list appears in the actual 
alarm message.

� Many entries specify file path names. While MS Windows notation %PABASE% and \ is 
used in the paths specified in the entries, you can replace them with $PABASE and / 
respectively for Solaris.

� In entries where lengthy path names must be broken, they are broken at a directory 
boundary. Always consider path names to be unbroken.
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Administration Manager alarm messages

Alarm message Description Resolution

Exception when resolving 
Admin Manager reserve server. 
Check MOMTAB to be sure it is 
being launched...

Unable to resolve 
administration manager 
reserve server with the 
naming service.

Check the %PABASE% 
\data\admin\mom\etc\momtab file to 
be sure the adm0 and admb entries 
are set to respawn, not off. 
Verify the ORBacus Naming Service is 
running. If the service is not running, 
see ORBacus Naming Service on 
page 110 for information about starting 
the service.

Exception when narrowing 
Admin Manager reserve server. 
Check MOMTAB to be sure it is 
being launched...

Unable to narrow the 
object reference.

Check the %PABASE% 
\data\admin\mom\etc\momtab file to 
be sure the adm0 and admb entries 
are set to respawn, not off.
Stop and restart adm0 using these 
commands: pa disable adm0 and 
pa enable adm0.

Exception when starting [adm1| 
adm2| adm3| adm4 | adm5] 
process...

Unable to connect to an 
administration manager 
server on the historical 
server.

Verify the ORBacus Naming Service is 
running. If the service is not running, 
see ORBacus Naming Service on 
page 110 for information about starting 
the service.
Check for networking problems.

Server [adm1| adm2| adm3| 
adm4 | adm5] failed to register 
with base server - exiting

The administration 
manager base server 
has died.

Execute the pa list command to see 
if admb is running. If not, restart it using 
pa enable admb.

Exception when resolving 
[adm1| adm2| adm3| adm4 | 
adm5]...

Unable to resolve one 
of [adm1| adm2| adm3| 
adm4 | adm5] with the 
naming service. This 
could be because the 
administration manager 
server is not running.

Reconnect from the Administration 
Client.

Exception when narrowing 
[adm1| adm2| adm3| adm4| 
adm5]...

Unable to narrow the 
object reference.

Stop and restart adm0 using 
pa disable adm0 and 
pa enable adm0.
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Exception when setting up 
monitoring of [adm0 | adm1| 
adm2| adm3| adm4 | adm5]...

Server did not start 
properly, or quit.

For adm0, stop and restart using pa 
disable adm0 and 
pa enable adm0.For others, if 
Administration Client is available, then 
attempt to reconnect to the server by 
selecting File > Reconnect, or restart 
the Administration Client.

AdminMgrSrvBaseServer 
unable to get lock. Check the 
momtab file to be sure that only 
one AdminMgrSrvBaseServer 
is being launched.

Unable to get lock. Check the %PABASE% 
\data\admin\mom\etc\momtab file to 
be sure there is only one 
AdminMgrSrvBaseServer set to 
respawn.
If logging in to the Administration Client 
with the OA User ID configured during 
installation, check permissions of the 
%PABASE%\data\runtime\lock 
directory and verify this ID has 
permission to write to this directory.
If logging in to the Administration Client 
with a different User ID, verify this User 
ID is a member of the OA Group ID 
configured during installation. Then 
check permissions of the 
%PABASE%\data\runtime\lock 
directory and verify this group has 
permission to write to this directory.

Alarm message containing error 
number 4202.

Unable to initialize the 
naming service.

Verify the ORBacus Naming Service is 
running. If the service is not running, 
see ORBacus Naming Service on 
page 110 for information about starting 
the service.

Exception raised during ORB 
initialization:...

Unable to initialize the 
ORBacus ORB; may 
be using incorrect 
ORB.

Verify in the 
%PABASE%\AdminPol.html (or 
%PABASE%\AdminSig.html) file that 
for the entry PARAM 
NAME="java_archive", jars/OB.jar 
and jars/OBNaming.jar are included in 
the VALUE specified.
Verify that the OB.jar and 
OBNaming.jar files exist in 
%PABASE%/jars directory.

Alarm message Description Resolution
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Exception raised during 
creation of mySrv:...

Problem with CORBA. Check system resources: disk space, 
memory, etc.
Contact Avaya customer support.

Could not publish object 
reference:...

Unable to publish an 
object reference with 
the naming service.

Verify the ORBacus Naming Service is 
running. If the service is not running, 
see ORBacus Naming Service on 
page 110 for information about starting 
the service.
Stop and restart the Administration 
Manager Base Server using 
pa disable admb and 
pa enable admb.

AdminMgrSrvBaseServer could 
not initialize as monitoree:...

Monitor cannot publish 
interface with the 
naming service.

Verify the ORBacus Naming Service is 
running. If the service is not running, 
see ORBacus Naming Service on 
page 110 for information about starting 
the service.
Stop and restart the Administration 
Manager Base Server using 
pa disable admb and 
pa enable admb.

Exception raised during 
impl_is_ready:...

Unable to start CORBA 
event loop.

Check the CLASSPATH environment 
variable to be sure that server.jar 
appears in the CLASSPATH before 
any JRE entries, or before any other 
ORB entries.

Alarm message Description Resolution
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AdminMgrSrvServer [0 | 1 | 2 | 3 
| 4 | 5] : failed to get lock for 
AdminMgrSrvServer [0 | 1 | 2 | 3 
| 4 | 5]...

Unable to launch an 
Administration Client.

Execute the pa list command to see 
if admb is running. If not, start it using 
pa enable admb.
Possible race condition; wait 30 
seconds and try again.
If logging in to the Administration Client 
with the OA User ID configured during 
installation, check permissions of the 
%PABASE%\data\runtime\lock 
directory and verify this ID has 
permission to write to this directory.
If logging in to the Administration Client 
with a different User ID, verify this User 
ID is a member of the OA Group ID 
configured during installation. Then 
check permissions of the 
%PABASE%\data\runtime\lock 
directory and verify this group has 
permission to write to this directory.

Alarm message containing error 
number 4701.

Monitor cannot publish 
interface with the 
naming service.

Verify the ORBacus Naming Service is 
running. If the service is not running, 
see ORBacus Naming Service on 
page 110 for information about starting 
the service.
Stop and restart this server.

Exception raised during 
Monitoree initialization for...

Monitor cannot publish 
interface with the 
naming service.

Verify the ORBacus Naming Service is 
running. If the service is not running, 
see ORBacus Naming Service on 
page 110 for information about starting 
the service.
Stop and restart this server.

System exception starting 
thread...

Unable to start thread 
to monitor activity of 
reserve server (adm0) 
and Administration 
Client servers.
Possibly out of threads.

Check system resources like: threads 
being used, and memory.
Contact Avaya customer support.

NotInitializedException raised 
during creation of mySrv...

Problem with CORBA. Check system resources like: disk 
space and memory.
Contact Avaya customer support.

Alarm message Description Resolution
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Cannot resolve reference to 
base server:...

Unable to resolve 
administration manager 
base server with the 
naming service.

Check the %PABASE% 
\data\admin\mom\etc\momtab file to 
be sure the admb entry is set to 
respawn, not off.
Verify the ORBacus Naming Service is 
running. If the service is not running, 
see ORBacus Naming Service on 
page 110 for information about starting 
the service.

Cannot narrow reference to 
base server:...

Unable to narrow the 
object reference.

Check the %PABASE% 
\data\admin\mom\etc\momtab file to 
be sure the admb entry is set to 
respawn, not off.
Stop and restart admb using
pa disable admb and 
pa enable admb.

AdminMgrSrvServer can't 
monitor base server...

Server did not start 
properly, or quit.

Stop and restart admb using 
pa disable admb and 
pa enable admb.

Exception raised during 
creation of myImpl...

Unable to start CORBA 
event loop.

Check the CLASSPATH environment 
variable to be sure that server.jar 
appears in the CLASSPATH before 
any JRE entries, or before any other 
ORB entries.

Alarm message Description Resolution
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Scheduler alarm messages

DBService alarm messages

Alarm message Description Resolution

ExecutionManager:: 
ExecutionManager: Process 
failed to start
schedule entry name:  
SomeName
process type:  
SomeProcessType

System scheduled 
process failed to start.

Check the Windows Event Log or 
Solaris $PABASE/data/log 
/CentralError/CentralErrorLog.log 
file for other error messages that may 
indicate the problem.
Operational Analyst will try to start the 
process at the next scheduled time. If it 
continues to fail then check the trace 
files associated with the process.
Contact Avaya customer support.

Alarm message Description Resolution

DBService:initialize: RT_359: 
Unable to connect to TimesTen 
DB.

Cannot connect to the 
TimesTen database.

Verify the TimesTen services are 
running: TimesTen Data Manager and 
TimesTen Server. Start them if they 
are not running. See Starting or 
stopping TimesTen on page 146 for 
information on starting TimesTen 
services.
If TimesTen is running, run ttisql and 
attempt to connect to the database. If 
this is successful then Contact Avaya 
customer support.
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Data Manager alarm messages

Alarm message Description Resolution

RT_113: Failed to initialize ORB Unable to initialize the 
ORBacus ORB. May be 
using an incorrect ORB.

Check the CLASSPATH 
environment variable to be sure 
that server.jar appears in the 
CLASSPATH before any JRE 
entries, or before any other ORB 
entries.

RT_115: Failed to initialize name 
service

Unable to initialize the 
naming service

Verify the ORBacus Naming 
Service is running. If the service is 
not running, see ORBacus Naming 
Service on page 110 for information 
about starting the service.

DataManager:DataManager()RT
_104: Failed to get properties.

Unable to get properties 
values.

Verify the administration manager 
is running.

DataManager:DataManager()RT
_135: Failed to get Default 
properties.

Unable to get properties 
values.

Verify the administration manager 
is running.

RT_108: ORB not initialized 
exception.

Unable to initialize 
connection monitoring.

Verify the ORBacus Naming 
Service is running. If the service is 
not running, see ORBacus Naming 
Service on page 110 for information 
about starting the service.
Stop and restart data manager.

RT_109: Error while initializing 
connection monitor.

Unable to initialize 
connection monitoring.

Verify the ORBacus Naming 
Service is running. If the service is 
not running, see ORBacus Naming 
Service on page 110 for information 
about starting the service.
Stop and restart data manager.



Alarm messages

Issue 1.0 August, 2002 127

RT_203: System initialization 
failed - Exiting

A process upon which the 
data manager depends 
failed to start, such as 
EventProcessor, or 
EventManager.

Check the Windows Event Log or 
Solaris 
$PABASE/data/log/CentralError/ 
CentralErrorLog.log file for other 
error messages that may indicate 
the problem and other details.
Check the %PABASE% 
\data\log\datamanager\dmTrc.log 
file for other trace messages.
May need to increase the trace 
level for the dm process, restart the 
data manager, and look at the log 
file again.

RT_208 Failed to register 
gateway with name service

Unable to register the 
gateway with the 
ORBacus Naming 
Service.

Verify the ORBacus Naming 
Service is running. If the service is 
not running, see ORBacus Naming 
Service on page 110 for information 
about starting the service.
Contact Avaya customer support.

DataManager:registerWithAMF() 
RT_139: Error creating 
ApplicationManager instance

Unable to create 
application manager 
instance.

Check system resources like disk 
space and memory.
Contact Avaya customer support.

DataManager:registerWithAMF() 
RT_140: Error creating 
ResourceManager instance...

Unable to create resource 
manager instance.

Check system resources like disk 
space and memory.
Contact Avaya customer support.

RT_200: Cannot write to event 
buffer files

I/O Error trying to write to 
file %PABASE% 
\add_on\data\dm 
\EventBufferX.txt

Check available disk space.
Check the permissions of 
%PABASE%\add_on\data\dm 
directory and EventBufferX.txt file 
and verify that the OA 
Administration User configured 
during installation has permission 
to write to this directory and file.
Verify the file is not currently in use 
(e.g. being edited).

RT_228: PABASE not set, 
cannot open event buffer files

PABASE environment 
variable is not set.

PABASE needs to be set to the 
base directory of the Operational 
Analyst installation.

Alarm message Description Resolution
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IntervalExportDone:processEven
t():Exception requesting 
Application Management Server 
to release database from 
Extreme load level

Unable to release 
database resource from 
extreme CPU load level. 
Possibly a CORBA error.

If AMS is not running then this is ok.
Run pa list command to see if the 
ams process is running. 
If AMS is running, then this 
condition should self-correct after a 
time-out period and the resource 
will be released.

BulkDeliverer:notifyAboutActiveF
iles():RT_111: CORBA call timed 
out for table SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

BulkDeliverer:notifyAboutActiveF
iles():RT_118: CORBA 
Communication Failure for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

BulkDeliverer:notifyAboutActiveF
iles():RT_137: Forwarder failed 
to take the data. for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

SynonymExporter:publishData()::
RT_111: CORBA call timed out 
for table SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

SynonymExporter:publishData()::
RT_118: CORBA 
Communication Failure for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

SynonymExporter:publishData()::
RT_137: Forwarder failed to take 
the data. for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

SynonymExporter:unloadDataAn
dNotify()::RT_111: CORBA call 
timed out for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

SynonymExporter:unloadDataAn
dNotify()::RT_118: CORBA 
Communication Failure for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

Alarm message Description Resolution
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SynonymExporter:unloadDataAn
dNotify()::RT_137: Forwarder 
failed to take the data. for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

WorkitemDataSet:attemptDataD
elivery()::RT_111: CORBA call 
timed out for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

WorkitemDataSet:attemptDataD
elivery()::RT_118: CORBA 
Communication Failure for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

WorkitemDataSet:attemptDataD
elivery()::RT_137: Forwarder 
failed to take the data. for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

WorkitemDataSet:notifyAboutAct
iveFile()::RT_111: CORBA call 
timed out for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

WorkitemDataSet:notifyAboutAct
iveFile()::RT_118: CORBA 
Communication Failure for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

WorkitemDataSet:notifyAboutAct
iveFile()::RT_137: Forwarder 
failed to take the data. for table 
SomeTableName

CORBA connection 
between data manager 
and forwarder went down.

Generally self-correcting. The 
alarm is cleared after the next 
successful CORBA call.

Alarm message Description Resolution
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Data Server alarm messages

Alarm message Description Resolution

DataServerMain: RT_104: Failed to 
get properties.

Unable to get properties 
values.

Check that the administration 
manager is running.

DataServerMain: RT_135: Failed to 
get Default properties.

Unable to get properties 
values.

Check that the administration 
manager is running.

DataServerMain:Main() RT_203: 
System initialization failed - Exiting

A process upon which the 
data server depends 
failed to start.

Check the Windows event log or 
Solaris $PABASE 
/data/log/CentralError 
/CentralErrorLog.log file for 
other error messages that may 
indicate the problem and other 
details.
Check the %PABASE% 
\data\log\dataserver\dsTrc.log 
file for other trace messages.
May need to increase the trace 
level for the ds process, restart 
the data server, and look at the 
log file again.

DataServerMain:Main() RT_314: 
The following required tables are 
missing from data base:...

Tables are missing from 
the TimesTen database.

Stop and restart data manager.
May need to use ttisql to drop 
u.wkheader table and then 
restart data manager.

DataServerMain:initializeCorba(): 
RT_114 :Failed to initialize BOA

Unable to initialize the 
ORBacus ORB.

Check system resources like 
disk space and memory.
Contact Avaya customer 
support.

DataServerMain:initializeCorba(): 
RT_328: Failed to register RDS.

Unable to register the 
report data server with 
the naming service.

Verify the ORBacus Naming 
Service is running. If the service 
is not running, see ORBacus 
Naming Service on page 110 for 
information about starting the 
service.
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DataServerMain:initializeCorba(): 
RT_330: Error in getting system 
state.

Verify the ORBacus Naming 
Service is running. If the service 
is not running, see ORBacus 
Naming Service on page 110 for 
information about starting the 
service.

DataServerMain:registerSubCompo
nents() RT_332: Exception: 
Unsupported version.

Incompatible IDLs. Possibly bad installation. 
Contact Avaya customer 
support.

DataServerMain:registerSubCompo
nents() RT_333: Failed to resolve 
gateway narrow.

Incompatible IDLs. Possibly bad installation. 
Contact Avaya customer 
support.

DataServerMain:registerWithAMF():
RT_139: Error creating 
ApplicationManager instance...

Unable to create 
Application Manager 
instance.

Check system resources: disk 
space, memory, etc.
Contact Avaya customer 
support.

DataServerMain:registerWithAMF():
RT_140: Error creating 
ResourceManager instance...

Unable to create resource 
manager instance.

Check system resources like 
disk space and memory.
Contact Avaya customer 
support.

DSRestartnum:restartNum: 
RT_381: Could not get strings from 
properties file to build restart num 
file name

Unable to get values from 
properties file.

Verify the administration 
manager is running.

DataSetManager:Constructor: 
RT_374: File Error...

File path does not exist. Verify 
%PABASE%\add_on\data\dsvr 
directory exists and that the OA 
Administration User configured 
during installation has 
permission to write to this 
directory. If the 
dsvr_restartnum.dat file exists 
in that directory, be sure that the 
OA Administration User 
configured during installation has 
permission to write to this file.

Alarm message Description Resolution
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Forwarder alarm messages

Alarm message Description Resolution

CMSAcd X has 15 minute 
intervals

CMS interval size is 
invalid for OA.

Unadminister that ACD source on OA 
using the Administration Client 
Interface Services page.
Change the interval value on CMS to 30 
following instructions in the CMS 
documentation. This involves data 
migration, etc.

SomeId :CMSCollector 
terminated abnormally...

An unhandled exception 
was thrown.

Restart the forwarder.
If the alarms persists, contact Avaya 
customer support.

SomeId :ECHCollector 
terminated abnormally...

An unhandled exception 
was thrown.

Restart the forwarder.
If the alarms persists, contact Avaya 
customer support.

SomeId :HDSCollector 
terminated abnormally...

An unhandled exception 
was thrown.

Restart the forwarder.
If the alarms persists, contact Avaya 
customer support.

SomeId :Buffer terminated 
abnormally...

An unhandled exception 
was thrown.

Restart the forwarder.
If the alarms persists, contact Avaya 
customer support.

SomeId :Exporter terminated 
abnormally...

An unhandled exception 
was thrown.

Restart the forwarder.
If the alarms persists, contact Avaya 
customer support.

SomeTableName: 
CMSReader: specific error 
message

There is a database 
problem causing 
SomeTableName to be 
unreachable for reading.

Specific error message should indicate 
more detail of the problem.
Verify database services are running.
Check that SomeTableName exists in 
the database.
Check for networking problems.
Check disk space.
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unable to open 
SomeFileName: specific error 
message

Unable to open file. Specific error message should indicate 
more detail of the problem.
Check permissions of SomeFileName 
and verify that the OA Administration 
User configured during installation has 
permission to write to this file.
Remove the file if it exists and its 
permissions are correct, and restart the 
forwarder.

unable to read 
SomeFileName: specific error 
message

Unable to open file. Specific error message should indicate 
more detail of the problem.
Check permissions of SomeFileName 
and verify that the OA Administration 
User configured during installation has 
permission to write to this file.
Remove the file if it exists and its 
permissions are correct, and restart the 
forwarder.

unable to read 
SomeFileName: infinite loop

Possibly corrupt file. Data has been lost, but the condition is 
self-correcting.

SomeTableName: buffer full; 
purging oldest data

Buffer became full. Data 
is lost.

Increase the size of the buffer using the 
Administration Client Interface 
Services page. This may improve 
future buffer performance during system 
outages.

unable to write 
SomeFileName: specific error 
message

Unable to write file. Data 
is lost.

Specific error message should indicate 
more detail of the problem.
Check disk space and free up space if 
possible.

Alarm message Description Resolution
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Forwarder or recorder alarm messages

Alarm message Description Resolution

SomeId :Clock terminated 
abnormally...

An unhandled exception 
was thrown.

Restart the forwarder or recorder.
If the alarm persists, contact 
Avaya customer support.

SomeTableName: CRTable: 
specific error message

There is a database 
problem causing 
SomeTableName to be 
unreachable for writing.

Specific error message should 
indicate more detail of the 
problem.
Verify database services are 
running.
Check that SomeTableName 
exists in the table.
Check for networking problems.
Check disk space.
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Event Collector alarm messages

Alarm message Description Resolution

EC.ICServerFailure: 
Unexpected IC server failure 

The IC CORBA 
infrastructure notified 
Event Colector (EC) that 
one of the required IC 
Servers failed (e.g., 
ADU Server, Directory 
Server).

In normal operating conditions the 
condition will be transient and EC will 
recover without any external 
intervention.
If the problem persists, verify:

� The network is operating normally. 

� All required servers are operational 
(no machines crashed).

� EC server and required IC servers 
(e.g., ADU Server, Directory Server) 
are properly configured.

If the problem persists, contact Avaya 
customer support.

EC.QueueSizeLimit: 
ECQueue: queueName has 
encountered a queue limit 
exception 

The named queue has 
exceeded its configured 
maximum size limit due 
to a performance 
bottleneck. 

Verify:

� Network throughput to data manager 
is adequate

� Data manager is operating normally 
and has adequate server resources 
(e.g., memory, CPU)

� The EC process is getting adequate 
server resources (e.g., memory, 
CPU). 

If the problem persists, contact Avaya 
customer support.
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EC.QueueHighWater: 
ECQueue: queueName has 
reached the high water mark. 

The named queue's size 
has exceeded the 
configured warning 
threshold.

Verify:

� Network throughput to data manager 
is adequate.

� Data manager is operating normally 
and has adequate server resources 
(e.g., memory, CPU).

� EC process is getting adequate 
server resources (e.g., memory, 
CPU). 

If the problem persists, contact Avaya 
customer support.

EC.ICMapperControllerFailed: 
An unexpected failure occurred 
in the EC process.

EC will be automatically 
shutdown and restarted. 
Additional details 
regarding the failure will 
be included in the error 
message. 

Contact Avaya customer support.

EC.ICMapperControllerFailed: 
Memory allocation failure, 
requesting EC shutdown 

EC ran out of memory 
during normal execution 
or the heap is corrupted. 

The server hosting EC may not have 
been configured with sufficient memory. 
Verify the host server has sufficient 
RAM. 
If the problem persists, contact Avaya 
customer support.

EC.ICServerSuccessfulAssign:
EC successfully assigned to an 
IC server. 

This is normal and 
expected during startup. 

No action required.

EC.ICProxyInitFailure: Failed 
to initialize ADU local proxy. 

Internal failure. Contact Avaya customer support.

EC.ICProxyInitFailure: Assign 
to local ADU server failed. 
Verify ADU server is configured 
correctly. 

EC was unable to 
connect to the local ADU 
Server 

Using IC Manager, verify that the local 
ADU server is properly administered and 
is running.

EC.ICProxyInitFailure: Failed 
to initialize DS proxy 

Internal failure. Contact Avaya customer support.

EC.AssignFailure: Assign to 
DS server failed. Verify DS 
server is configured correctly 

EC was unable to 
connect to the IC 
Directory Server. 

Using IC Manager, verify the IC 
Directory Server is properly 
administered and is running.

Alarm message Description Resolution
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EC.LostDataManager 
Connection: Connection to 
DataManager was lost. 

The EC connection to its 
associated data 
manager process failed. 

Under normal conditions EC will recover 
the connection to the data manager. 
If the problem persists for more than a 
couple of minutes, verify:

� The associated data manager is 
executing and is reachable (ping 
the datamanager host machine)

� The ORBacus Naming Service is 
operational. 

� If the problem persists, contact 
Avaya customer support.

EC.EstablishedDataManager 
Connection: Connection to 
DataManager has been 
established. 

EC has successfully 
established connectivity 
to its associated data 
manager 

No action required.

EC.ConnectionMonitoring: 
Failed to initialize the 
monitoree interface. 

Internal EC Error Verify the local ORBacus Naming 
Service is operating normally. 
If the problem persists, contact Avaya 
customer support.

EC.ORBacusInitialize: Failed to 
initialize ORB server. 

EC failed to initialize its 
CORBA infrastructure. 

The most likely cause of this problem is 
an improper installation of EC. Reinstall 
EC per the OA Installation and 
Maintenance Guide and restart. 
If the problem persists, contact Avaya 
customer support.

EC.ConnectionMonitoring: 
ConnectionMonitor 
AlreadyInitializedException. 

EC failed to initialize its 
CORBA infrastructure. 

The most likely cause of this problem is 
an improper installation of EC. Reinstall 
EC per the OA Installation and 
Maintenance Guide and restart. 
If he problem persists, contact Avaya 
customer support.

EC.ConnectionMonitoring: 
ConnectionMonitor 
CORBA::SystemException. 

EC failed to initialize its 
CORBA infrastructure. 

The most likely cause of this problem is 
an improper installation of EC. Reinstall 
EC per the OA Installation and 
Maintenance Guide and restart. 
If the problem persists, contact Avaya 
customer support.

Alarm message Description Resolution



OA Features

138 Operational Analyst Troubleshooting Guide

EC.ConnectionMonitoring: 
ConnectionMonitor 
InitializeException. 

EC failed to initialize its 
CORBA infrastructure. 

The most likely cause of this problem is 
an improper installation of EC. Reinstall 
EC per the OA Installation and 
Maintenance Guide and restart. 
If the problem persists, contact Avaya 
customer support.

EC.ORBacusInitialize: Couldn't 
start the CORBA event loop. 

EC failed to initialize its 
CORBA infrastructure. 

The most likely cause of this problem is 
an improper installation of EC. Reinstall 
EC per the OA Installation and 
Maintenance Guide and restart. 
If the problem persists, contact Avaya 
customer support.

Alarm message Description Resolution
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Error messages
Operational Analyst utilizes a central error logging concept for tracking warning and error 
conditions that occur. When a warning or error occurs, Operational Analyst records a 
message in a log file on the local machine. Event, audit and alarm messages are also 
recorded into this log file.

Windows message log
On Windows NT and Windows 2000 systems, the messages are logged by the Event Log 
Service. In order for Operational Analyst to log the messages, the Event Log Service must 
be running. This service is generally started automatically.

To verify the Event Log Service is running on the Operational Analyst server:

1. Go to Start > Settings > Control Panel > Services on NT or Start > Settings > 
Control Panel > Administrative Tools > Services on Windows 2000.

2. Look for EventLog.
The status of this service should be Started. If it is not, click the service and click Start 
to start the process.

Configuring the log

Many Windows applications log messages into the Event Log, including Operational 
Analyst. If the log file reaches capacity, no more messages can be stored, possibly 
resulting in the loss of valuable troubleshooting information. To ensure adequate log file 
space, you should increase the log size to at least 2 MB.

To increase the size of the log:

1. Start the Event Viewer:

Start > Programs > Administrative Tools (Common) > Event Viewer on Windows 
NT or Start > Settings > Control Panel > Administrative Tools > Event Viewer on 
Windows 2000.

2. Select the application log:

Log > Application on Windows NT or select Application Log from the tree-view on 
Windows 2000.

3. Open the log properties dialog:

Log > Log Settings on Windows NT or Action > Properties on Windows 2000.

4. Enter the desired size in the Maximum log size text box.

5. Select OK to save your change.
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You can specify the behavior the Event Log exhibits when the log file reaches capacity by 
choosing one of the options in the Event Log Wrapping (Windows NT) or When 
maximum log size is reached (Windows 2000) section of the log properties dialog:

� Overwrite events as needed results in removing the oldest message when a new 
message is written. 

� Overwrite events older than X days may result in the log file reaching capacity, 
depending on message volume, log file size, and the number of days specified.

� Do not overwrite events (clear log manually) results in the log file reaching capacity 
unless you monitor and maintain it regularly.

Carefully consider which option fits your system requirements, and maintain the log file 
appropriately by saving its contents to a file and then clearing the file on a regular basis.

Viewing the log

The central error log messages can be viewed using the Event Viewer, which allows users 
to view events on the local machine. On NT, users can also view events of other machines 
on the network.

To view events:

1. Go to Start > Programs > Administrative Tools (Common) > Event Viewer on NT 
or Start > Settings > Control Panel > Administrative Tools > Event Viewer on 
Windows 2000.

2. Select Application from the Log menu to view the application log.

You can select individual events and double-click them to see event details. Warning, 
error, event and audit messages are logged into the event log, as well as alarm 
messages that have also been forwarded to the Alarm Manager.

In the Event Viewer, the Source value of Operational Analyst messages is usually prefixed 
with OA_ to facilitate filtering Operational Analyst messages. Messages are assigned a 
Type based on their priority. This table describes the assignments.

Note:
Audit messages pertain to security events such as logon on the 
Administration Client or accessing secure files.

Type Priority Message content Icon

Error High Alarms, high severity errors Red stop sign

Warning Medium Warnings, event level messages Yellow !

Information Informational Informational and audit messages Blue i
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Solaris message log
On Solaris, the error, warning, event and audit messages are logged in a central error log 
file that can be viewed by editing the file with any text editor. The file is a simple text file 
that resembles the trace log files. There is no log viewer for viewing these messages. The 
central error log file resides in the $PABASE/data/log/CentralError directory and is 
named CentralErrorLog.log.

The messages in the central error log for both Windows and Solaris are prefixed with 
priority and severity indicators to help track conditions that require immediate attention. 
The priority indicators are:

� ALARM
� ERROR
� EVENT
� AUDIT
and the severity indicators are:

� emergency
� high
� low
� info

Internet Information Services (IIS) message log
Internet Information Services (IIS) has its own logging mechanism. When running OA 
reports, log entries are created each time a basic report is accessed and each time that a 
basic real-time report is refreshed. When a large number of reports are accessed, the IIS 
log files can grow to a large size and consume large amounts of disk space. These log files 
grow progressively because IIS has no mechanism in place to automatically remove older 
files. If disk space becomes full, this can impact performance of OA processes on that 
system. Therefore, one of the following should be done:

� Turn off logging for the OA reports. If this logging is turned off, no log entries will be 
written for any OA Basic report access or report refresh.

� Administer IIS to create these log files on a disk partition dedicated solely to report 
logging. If this disk becomes full, there will be no performance impact to OA or Basic 
reports, but no reporting messages will be written to the log files.

� Continually monitor the disk space consumed by these log files and purge files as 
needed.
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Turn off logging for OA reports

To turn off logging for the OA reports:

1. As an Administrator, start the Internet Service Manager.

2. Expand the tree to servername > Default Web Site.

3. Right click on jakarta and choose Properties.

4. Under the Virtual Directory tab of the jakarta Properties window, uncheck the Log 
visits box.

Create a specific logging directory

If you create a dedicated disk partition to contain IIS log files, follow these steps to change 
the IIS logging directory:

1. As an Administrator, start the Internet Service Manager.

2. Expand the tree to servername > Default Web Site.

3. Right click on Default Web Site and choose Properties.

4. Under the Web Site tab of the Default Web Site Properties window, click on the 
Properties box.

5. In the General Properties tab of the Extended Logging Properties window, under 
Log file directory enter the directory into which logs are to be created.



Forwarders and recorders

Issue 1.0 August, 2002 143

Forwarders and recorders
Forwarders and recorders are responsible for feeding data to Operational Analyst and 
making sure it is appropriately placed in the data stores. If data is missing from historical or 
real-time stores, or seems to be inaccurate compared to known IC or CMS activity, check 
to be sure the forwarders and recorders are correctly administered. Refer to the 
Operational Analyst Administration Client Help for details.

The dcstat (data collection status) command displays status and statistics of forwarders 
and recorders. The dcstat command uses the following syntax:

dcstat -n [fwd|rec]datastore [-a | -l | -c | -b | -r] 
[-h <host>] [-i] [-v 0|10|20|30] [-z]

dcstat -n dm [-h <host>] [-i] -s <source>

dcstat -n [db|<table>]

For example, if you want to view all status of the forwarder for the agent data store, enter:

dcstat -n fwdagent -a

-a Display all status. This is equivalent to -l -c -b -r.

-b Display status of data buffering.

-c Display status of data collection.

-h The service is on the specified host.

-i Display the supported CORBA interface objects of the forwarder or 
recorder. Display the supported tables of the dm.

-l Display status of data listening.

-n The name of a service, database, or database table. For a forwarder or 
recorder, the prefix indicates the type and the suffice is an historical 
data store. For example: fwdcmscallhistory. For a dm, the name is �dm.� 
for a database, the name is �db.� Anything else is assumed to be a table 
in the database.

-r Display status of data recording.

-s Source id that identifies a dm.

-v Acivate/deactivate the trace by hanging the verbosity level. For 
example, 0 means off, 10 means trace events, 20 means trace 
interfaces, 30 means trace low-level functions.

-z Reset all statistical counters to zero.
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If you want to change the trace level for the recorder for the cmsskill data store to a debug 
level enter:

dcstat –n reccmsskill –v 30
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The CORBA interface
The diag command is used to test the basic sanity of CORBA communication. If problems 
exist within this interface, this tool can help to diagnose where the problem is. It does not 
test specific communication paths between individual components. The diag command 
exists in the %PABASE%\bin directory and is executed using the Command window. 

Note:
For Solaris, the command is diag.sh.

To use the diag command, on the Operational Analyst server machine enter the following:

diag server

On the Operational Analyst Administration Client machine enter the following (including the 
quotes):

diag client “-DHOST=hostname”

where hostname is the host where the CORBA server is running. 

Note:
The quote marks (“ ”) are required with this command.

The resulting output is displayed on each machine as each level of the interface is tested. 
If the CORBA interface is working completely, then you will see the client sending data to 
the server, and the server receiving the data successfully. This command is most useful in 
a multiserver environment in which diag client is run on one machine and diag 
server is run on another machine.
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TimesTen database
TimesTen is the physical database that hosts the Operational Analyst real-time database. 
This section provides some information about monitoring and troubleshooting TimesTen.

TimesTen documentation
TimesTen documentation is included on the Operational Analyst distribution media. During 
the installation process the documentation is place in these locations:

� Windows NT and Windows 2000: C:\TimesTen\TimesTen4.3\Docs.

� Solaris: $PABASE/doc/TimesTen.

Note:
To view the documentation you must have Adobe Acrobat Reader 5.0 or 
later installed.

Starting or stopping TimesTen
Information about the procedure for starting or stopping TimesTen is located in TimesTen 
Reference Guide Release 4.3, Chapter 5 Working with the TimesTen Data Manager 
Daemon. This manual is in file tt_ref.pdf in the documentation directories defined above.

Increasing TimesTen verbosity level
To assist in debugging TimesTen problems, increase the verbosity level:

1. Edit the srv\info\ttendaemon.options file in the TimesTen base directory.

2. Remove the # symbol from the #verbose line.

3. Stop and restart the TimesTen services as described above.

4. When debugging is complete, replace the # symbol.

Note:
Be sure the # is in place in the file during normal operation.

Monitoring TimesTen memory usage
The best way to monitor memory usage in TimesTen is to use ttIsql and the dssize 
stored procedure. There is no explicit logging done in TimesTen or OA to notify users that 
a memory threshold setting has been exceeded. 
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If you see TimesTen-related errors logged by OA, and the associated TimesTen error 
numbers are 802 or 6220 through 6223, TimesTen is notifying OA of memory related 
issues. 802 is an �out-of-memory� error, and the others are �threshold exceeded� warnings.

TimesTen error and warning messages can be viewed in the TimesTen Reference Guide. 
It is available in file tt_ref.pdf in the documentation directory described in TimesTen 
documentation on page 146. There are several other good documents in there as well, 
including more info on ttIsql and dssize.

To run dssize:

1. At the command line type ttIsql -connStr "dsn=dss128". 

2. At the Command> prompt, type dssize m; 

dssize displays the memory usage (in MB) similar to this:

DS_MAX_SIZE:          33 
DS_ALLOCATED_SIZE:        33 
DS_IN_USE_SIZE:           2 
PERM_ALLOCATED_SIZE:      25
PERM_IN_USE_SIZE:         1 
PERM_IN_USE_HIGH_WATER: 1 
TEMP_ALLOCATED_SIZE:      8 
TEMP_IN_USE_SIZE:         1
TEMP_IN_USE_HIGH_WATER:   1

where:

Parameter Represents

DS_MAX_SIZE: Overall maximum size of the datastore. This includes 
perm and temp sizes.

DS_ALLOCATED_SIZE: Allocated memory

DS_IN_USE_SIZE: Memory in use out of the total allocation

PERM_ALLOCATED_SIZE: Size of the permanent memory segment. This is 
where OA tables are stored.

PERM_IN_USE_SIZE: Out of the allocation, how much is actually in use.

PERM_IN_USE_HIGH_WATER: High water mark. This may be higher than in_use.

TEMP_ALLOCATED_SIZE: Size of the temporary memory segment. This 
segment is used byTimesTen for temporary tables.
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Troubleshooting TimesTen
The following sections describe TimesTen problems and suggested corrective actions.

TimesTen will not start

If the TimesTen database will not start, review the TimesTen log files for clues about the 
cause of the problem. The most common reasons for failure are listed in this table:

TimesTen data store corruption

It is possible for the TimesTen database to get into an inconsistent state that will prevent 
applications from connecting to it. There are a couple of ways to detect that this has 
happened. The first is that the data manager and/or data server processes will not 
complete initialization, or will fail after initialization. In this case these processes will report 
one or more of the following errors:

� RT_359: Unable to connect to TimesTen DB

� RT_129: Unable to recover from error encountered processing a database request; The 
RT Service is being shutdown to initiate recovery.

� TimesTen error message: data store segment inconsistent and corrupt

The second way to detect and/or confirm that there is a TimesTen database problem is to 
attempt to connect to it using the ttIsql utility. To do that, perform the following at the NT 
command prompt:

ttIsql 

connect "dsn=dss128";

Reason for failure Corrective action

Inadequate paging file size Set the paging file (swapfile) to 150% - 
200% of the RAM installed in your 
system.

Database corruption See TimesTen data store repair below.

C:\temp directory does not exist. Set the TEMP and TMP environment 
variables to point to the desired �temp� 
directory.
If TimesTen still does not start, create 
C:\temp.
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If, after step 2, ttIsql reports an error connecting to the database, or reports that a 
recovery is under way and that recovery does not complete in a reasonable amount of 
time, then it is likely that the database is corrupt and must be rebuilt from scratch.

TimesTen data store repair

If the NT Event Log on the real-time server shows repeated errors from the TimesTen data 
manager indicating that the data store segment is inconsistent and corrupt, and repeated 
efforts to connect to the database fail, a manual procedure may be necessary to recover 
from this situation.

General TimesTen problems

To troubleshoot other general problems with TimesTen, refer to the TimesTen JDBC 
Guide Release 4.3, Chapter 11 Troubleshooting. This manual is in files JDBCguide.pdf.

Action Details

1. Stop the real-time data manager 
and data server

Use the Administration Client Interface 
Services screen to disable the data manager

2. Move all TimesTen files to another 
location (they may be needed later to 
diagnose specific problems).

The TimesTen files are located in 
%PABASE%\add_on\TimesTen (Windows) 
or $PABASE/add_on/TimesTen 
(Solaris).The filenames have the pattern 
rtpa.txt.*.

3. Force the re-creation of the 
TimesTen database

From the command prompt:
ttIsql 

connect "dsn=dss128;OverWrite=1";

exit;

4. Start the real-time data manager 
and data server

Use the Administration Client Interface 
Services screen to enable the data manager. 
The data store should recover and a pump up 
will be initiated automatically.
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Data Manager and Report Data Server
Data manager (DM) stores data originating in IC into the real-time database. Real-time 
data is used in real-time reports and is also forwarded to the historical database. If real-
time reports do not reflect current data, or if the real-time database appears to be missing 
data, there may be a problem with the data manager process. It may be improperly 
administered, or it may not be in an operational state. Check data manager status via the 
Administration Client (see Operational Analyst Administration Client Help) or by using the 
pa command.

Report data server (RDS) provides up-to-date data to the real-time reports. It monitors the 
real-time database for changes to data and forwards the changes to the reporting 
subsystem. If real-time reports do not reflect current data, there may be a problem with the 
data server process. It may be improperly administered, or it may not be operational. 
Check data server status via the Administration Client (see Operational Analyst 
Administration Client Help) or by using the pa command.

Data manager or report data server fails
If the data manager or the report data server fail to start or fail after initially starting, take 
these actions:

1. Check the process logs for details about the failures. The logs are:

and are located in:

See Trace files on page 113 for more information on tracing and logging.

2. Verify that the Orbacus Naming Service is running and operational. See 
Troubleshooting map on page 10 for details.

3. Verify that TimesTen is running by looking for the TimesTen Data Manager service in 
the services log.

4. If TimesTen is available and operational, use ttIsql to verify TimesTen is accessible. 
See TimesTen data store corruption on page 148.

5. If ttIsql cannot access TimesTen, see Troubleshooting TimesTen on page 148.

Data manager datamanager/dmTrc.log

Data server dataserver/dsTrc.log

Windows NT and Windows 2000 %PABASE%/data/log

Solaris $PABASE/data/log
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Event Collector
The event collector (EC or EC Server) captures real-time events from the IC system and 
forwards them to the data manager. If EC is not administered correctly, or is not operating, 
no new contact center information is available for real-time reporting or for aggregation and 
reporting in the historical database. Check EC administration and status via the IC 
Manager application. See the Operational Analyst Installation and Maintenance Guide for 
details on how to configure the EC.

Event Collector logs
EC log files can be found in $PABASE/logs/ecServerName.log where ecServerName is 
the name of the EC instance configured in IC Manager.

The logging flags are set in IC Manager. Select the Server tab and the ECServer process. 
In the resulting dialog select the Debug tab, then click Trace Levels. The Trace Levels 
dialog box appears with the following options:

Flag Definition

usr1- General EC server logging enabled. Logs EC startup and shutdown messages.

usr2 - ICServerProxy package logging 
enabled.

Logs interactions with IC servers.

usr3 - EventMapper package logging 
enabled.

Logs data transformation performed in 
preparation for forwarding to the 
datamanager.

usr4 - ECCommon package logging 
enabled.

Logs general EC services messages.

usr5 - EC/OA IDL package logging 
enabled.

Logs high level interactions between EC 
and data manager.

usr6 - RTProxy package logging enabled. Logs detailed data sent from EC to data 
manager.

usr7 - General debug tracing logging 
enabled.

Debug logging in EC enabled. Do not use 
unless directed by Avaya support.

usr8 - Function entry and exit logging 
enabled.

Detailed EC function tracing enabled. Do 
not use unless directed by Avaya support.
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Other non-EC specific logging flags of interest include:

EC can also �record� incoming and outgoing events. This can be very useful for replicating 
problems. Recording is enabled via configuration variables that are defined in the EC 
server configuration dialog described above for the logging flags. Instead of opening the 
Debug tab, open the Configuration tab. On this tab, the following parameters control 
recording:

Note:
Do not enable recording via the ECR* flags listed above unless directed to 
do so by Avaya customer support.

Event Collector fails
If the event collector fails, take these steps:

1. Verify the EC is configured per the Avaya Operational Analyst Release 6.0 Installation 
and Maintenance Guide. Verify that the following options are populated and configured 
correctly for EC in the IC Manager:

� Site
� Real-Time System ID (the OA real-time Source ID)

� Data Manager Host
� SOURCE_ID

2. Start the Event Collector via the IC Manager.

3. Check the IC Manager for the Event Collector status.

The status should be reported as Up.

Flag Description

msg Incoming/outgoing messages from/to IC 
servers.

flush Immediately flushes I/0 to disk.

Parameter Values

ECR_ENABLED=y             enables recording, default is n 

ECR_ROLLOVER_BYTES=bytes  0 disables file size limits, default is 1MB 

ECR_ROLLOVER_FILES=num  0 disables limits, default is 10 

ECR_ROLLOVER_SECONDS=num  0 disables, default is 0; 1800 is useful for 1/2 
hour snapshots
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4. Inspect the error logs to be sure the pre-requisite services are available:

� ORBacus Naming Service
On Windows, check system Services to verify that ORBacus Naming Service is 
Started.   On Unix, use ps -ef | grep nameserv to see if nameserv is in the 
list of running applications.  If the local ORBacus Naming Service is not running, an 
alarm is logged by EC similar to: EC.ConnectionMonitoring, emergency, Failed 
to initialize the monitoree interface.

� ADU
Verify that the ADU server in the EC server local domain has a status of Up.

� DS
Verify that at least one IC Directory Server (DS) for the site has the status of Up.

5. If the Event Collector cannot connect to the Data Manager:

� Verify that the correct values are administered in IC Manager for the Real-Time 
System ID and the Data Manager Host name or IP address of the target real-time 
system.

� Verify that the Data Manager process is running on the target OA real-time system.

� If the Event Collector and the OA real-time system are installed on separate 
machines, verify the network is operating correctly by attempting to ping the 
associated Data Manager host server from the EC host server.

Poor Event Collector performance
Event Collector performance can be affected by many situations, including:

� An improperly configured host server can result in poor event collector performance. 

� Inadequate physical memory can increase virtual memory paging to the point where 
event collector cannot process any events. 

� An overloaded server running too many IC or OA processes. Symptoms of this type of 
problem include:

� Poor EC performance

� EC �Queue limits exceeded� errors

� Failures of other IC or OA processes co-located with EC.
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Schema migration
Schema migration may encounter some errors. This section defines the errors and the 
trace file.

Trace file for schema migration
The trace file for schema migration is:

%PABASE%\data\log\migration\MigrationTrc.log

Schema migration errors
The following errors may occur during schema migration.

Error Description

COMMON_NOLOCKS (559) All locks in use error.

DB_SQL (1078) Database General SQL error.

OBJ_INVALID_STATE (4301) An object is in an invalid state.

ADMIN_LONG_MIGRATION_NEEDED 
(12126)

Migration required.

METADATA_DATA_INCONSISTENCY 
(12301)

Metadata data inconsistency error.

MIG_UNABLE_TO_DECLARE 
(12701)

Unable to declare a schema migration.

MIG_UNABLE_TO_START (12702) Schema migration is unable to start.

MIG_UNABLE_TO_COMPLETE 
(12703)

Schema migration started but was 
unable to finish.

MIG_BUSINESS_RULE_VIOLATION 
(12704)

Migration violated a business rule, such 
as attempting to modify a schema that 
does not exist.

MIG_FAILURE (12705) Migration failed, recovery not possible.
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Stumbras
Stumbras is the Reporting Framework that provides communication between a Web 
(HTTP) server and Basic Reports. Stumbras also provides services that maintain historical 
database pool connections and real-time connections.

Error logging
Stumbras offers a logging service, which by default logs to the Operational Analyst main 
logger and the Stumbras in-memory logger. The level of debugging information captured is 
controlled by the LoggingService.xml file, which is modified via the Logging Admin page 
available at http://hostname/stumbras/admin. Do not edit LoggingService.xml directly. 
Doing so may corrupt its contents.

To increase the number of messages captured, set the log level to DEBUG. Use this level 
carefully since increasing the number of messages can affect disk space and system 
performance.

Note:
You must have administrator privileges to set the debugging level.
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Trouble situations and solutions
This table lists some common Stumbras trouble situations and solutions.

Problem Possible cause Solution

Cannot connect to the 
database.

Profile service failed. Verify the dbname assigned is the 
same as the dbpool name used 
by the DbPool service. (The name 
is case sensitive.)

Verify the JDBC driver name 
matches the relevant HTDB server 
type. The implementation class 
should be:

� Oracle:
com.avaya.stumbras.services.prof
ile.Oracle8iStorage

� SQL Server 2000:
com.avaya.stumbras.services.prof
ile.JdbcBlobStorage

Report tree-view is not 
displayed.

Stumbras failed to start. Check these log and error files for 
information:
$OADIR/data/log/reports/ 
reportlog.XX.log
� ../tomcat/jvm.stderr
� ../tomcat/jvm.stdout
� ../tomcat/hs_pidXXX.log 

(where XXX is some number)
� ../tomcat/logs/isapi.log
� ../tomcat/logs/jasper.log
� ../tomcat/logs/servlet.log
� ../tomcat/logs/tomcat.log

No real-time reports run 
and an error page is 
displayed.

RTPA service failed to 
start.

Verify the Admin Manager is 
running and is configured for 
Stumbras.
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No historical reports run 
and an error page is 
displayed.

DbPool service failed to 
start.

Verify the Admin Manager is 
running and is configured for 
Stumbras.

Valid Stumbras users 
are denied access.

Authorization server 
failed.

Verify the authorization server is 
running.

Note:
After 3 consecutive 
login failures, you 
must wait for 10 
minutes before 
trying again to avoid 
being locked out.

Problem Possible cause Solution
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Operational Analyst Glossary

Administration screen Screen on the right side of the Operational Analyst Client interface that contains 
information about configuration settings which are selected in the navigation tree.

Agent A customer service representative (CSR). An agent is a person qualified to handle 
customer requests. He or she may may deal with customers directly or just process 
customer requests.

Aggregated data Data that Operational Analyst has aggregated or summarized. Aggregated data has 
the minimum value (least), maximum value (greatest), sum, or a combination of 
those values, for each data period. Each column in the schema can be set to a 
different aggregation behavior, as long as it contains numeric data.

Aggregation occurs at an offset after the end of each base interval. The default offset 
is 10 minutes, but the offset can be set from 10 to 25 minutes by modifying the 
system scheduled aggregation job.

Aggregation Operational Analyst aggregates or summarizes data by selecting the minimum value 
(least), maximum value (greatest), or sum of a numerical measure for a particular 
data period. A data period involves one base interval. 

Aggregation job Job that aggregates data. An aggregation job summarizes data by selecting the 
minimum value (least), maximum value (greatest), sum of each data period, or a 
combination of those options. 

A system scheduled aggregation job runs at an offset after the end of a base 
interval. The default offset is 10 minutes, but the offset can be set from 10 to 25 
minutes by modifying the system scheduled aggregation job. This job aggregates 
data for that interval only.

An on-demand aggregation job can aggregate data for multiple intervals, up to 24 
hours of data.

Aggregation recovery 
job

Job that re-aggregates and archives container data that was not successfully 
aggregated in the past 30 hours. If enabled, the aggregation recovery job runs every 
six hours and aggregate data that was not successfully aggregated in previous 
attempts.

API Application Program Interface. An API is a set of routines that allows an application 
program to gain access to the operating system or application program. A developer 
who wants to build a program that makes requests to the operating system or 
application must use the prescribed method.
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Archive The act of compressing and summarizing aggregated data into the historical 
database. While aggregation occurs every base interval, archiving occurs on a daily, 
weekly or monthly basis, with the frequency determined by your configuration in the 
Container Limits administration screen.

Archived data Aggregated data that has been stored in the historical database. The data 
iscategorized into daily, weekly and monthly archives.

Base interval Operational Analyst lumps IC real-time data into 30-minute intervals in the historical 
subsystem.

Also called intervals.

See also base interval data.

Base interval data Real-time data that Operational Analyst has lumped into 30-minute intervals. The 
real-time subsystem summarizes IC data into 30-minute intervals and transfers it to 
the historical subsystem, which proceeds to aggregate the base interval data into 
containers.

Container Metadata that defines how data should be sifted and stored in the historical 
database. The term "container" encompasses both the table definition as well as the 
data contained in the table.

Container aggregation 
job

Scheduled job that aggregates selected containers. You specify the aggregation 
period and select the containers in the Scheduled Jobs administration screen.

Container data purge job Scheduled job that purge aggregated and archived data. You specify which data in 
the containers and archives to delete in the Scheduled Jobs administration screen.

Container filter Container definitions that you customize. A filter determines which fields of the base 
interval data are aggregated into a container. It specifies the name, data fields and 
default values for each container.

Container limit Limit or constraint that you set on your containers. This enhances data calculation 
performance and disk usage. You can configure the maximum number of containers 
and rules in the Container Limits administration screen.

Container profile Includes the definition and the name of a container. Container profiles contain rules 
that detail what fields a container should have and what sort of data it should collect. 
Each container has a profile which has a filter that may contain from one to 100 
rules.

Container rule Defines which rows of data in the historical store should be collected. Each container 
has a profile and a profile may have from one to 100 rules.

Also called filter rules or rules. 
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Coordinated Universal 
TIme

Coordinated Universal Time (UTC). Formerly called Greenwich Mean Time (GMT). 
UTC reflects the time in the prime meridian and uses a 24-hour format. For example, 
it uses 14:00 to represent 2:00 p.m.

Operational Analyst stores data in UTC but converts the time to the local time of the 
client.

CORBA Common Object Request Broker Architecture. CORBA is a way to create and 
manage distributed program objects in a network. It lets programs developed by 
different vendors or programs scattered throughout different servers communicate. 
A program in a client can request services from a program in a server without having 
to understand where the server is in a distributed network or what the interface to the 
server program is.

Current schema The existing schema that is being used. The current schema is the pre-migration 
schema. 

Daemon A program that runs continuously in the background and handles periodic service 
requests. The daemon forwards the requests to other programs or processes them 
as appropriate. 

Daily interval A 24-hour shift that Operational Analyst uses for real-time statistical reporting.

Data dictionary A database about data and databases. The data dictionary holds the name, type, 
range of values, source, and authorization for access for each data element in the 
contact center's files and databases.

Data manager An interface service that resides on a server where a real-time subsystem is 
installed. The data manager receives events, maintains real-time status information, 
summarizes data into fixed thirty-minute intervals, and forwards the data to the 
forwarders, a set of real-time subsystem services.

Data type Category of data. Each type is a set of data with values that have predefined 
characteristics and has a specified range of values and a specific way of being 
processed by the computer and stored by the database. 

Database check job A job that inspects the overall state of the historical database. A database check job 
fine-tunes the database by scanning the database and its error logs, as well as 
updating the statistics on tables. It also reports inconsistent metadata and rolls over 
the error log file to prevent it from growing unbounded. It runs daily if enabled.

Default schema Schema that is pre-configured in Operational Analyst. You can revert back to the 
pre-configured default schema if you decide to discard your changes. You need to 
migrate your data, however.

Detail data Historical data that cannot be aggregated.

Detail data contains information about the work item, such as the customer ID, work 
item ID and the origination.
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Detail data purge job Scheduled job that purges selected detail data. You select which detail data to purge 
in the Scheduled Jobs administration screen.

Disabled container Container that is not collecting or aggregating data.

Disabled interface 
service

Data collection service that is not running.

Disabled job A job that has been configured but is not activated to run.

Display name A meaningful name associated with a value in the database. For example, instead of 
displaying the agent ID, Operational Analyst Administration Client displays the agent 
name; so it will display "John Smith" instead of "1021454540554."

Enabled container Container that is collecting or aggregating data. 

Enabled interface 
service

Data collection service that is running.

Enabled job A job that will execute at scheduled times. See also disabled job.

Event An activity or change of state that occurs in a contact center. Examples include: a 
change in port state, an agent logging in, or a call transfer.

Execution frequency See recurrence.

External job Custom-designed instruction set that specifies when certain processes should be 
executed. You can add an external job, whose scripts reside in the historical server, 
into Operational Analyst Administration Client and schedule its execution.

Failed Data collection status that indicates database errors.

Filter See container filter.

Filter rule See container rule.

Flat file An independent data file that is not related to another file. Flat files can be related to 
other data files, but only if you program them to do so.

Forwarder An interface service that resides on CMS or real-time subsystems. The forwarder 
transfers the data it receives to its corresponding recorder. When the recorder is not 
available, the forwarder buffers the detailed data until the recorder is on-line again.
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GMT Greenwich Mean Time. Also known as UTC (Coordinated Universal Time). GMT 
reflects the time in the prime meridian and uses a 24-hour format. For example, it 
uses 14:00 to represent 2:00 p.m.

Operational Analyst stores data in UTC but converts the time to the local time of the 
client.

Historical database Where all historical data about your contact center is stored.

Historical store Storage location where historical or long-term contact center performance 
information is stored in a database. Each historical store consists of a database table 
or a group of database tables. Operational Analyst has 11 stores that accumulate a 
variety of report-related data from IC or ACD systems.

The IC historical stores are: 

� Agent service class

� Agent state

� Service class summary

� Service class state

� Display names
The ACD historical stores are:

� CMS agent summary

� CMS call work codes

� CMS skill summary

� CMS VDN summary

� CMS call history

� CMS display names

Historical subsystem Along with the source subsystem, real-time subsystem, reporting subsystem, and 
CMS subsystem, the historical subsystem constitutes the Operational Analyst data 
collection system. The historical subsystem pertains to all Operational Analyst 
components and services that involve historical data.

IC Avaya � Interaction Center.

IDL See Interface Definition language.

Incomplete Data collection status that indicates there is missing data and the container or 
archive is missing at least one base interval data.

Info store Historical store with a group of database tables that keeps track of the display 
names for the data fields.
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Interface definition 
language

A language used to communicate with various software components in a CORBA 
network.

Interface service Process that automatically collects data in the background while the system is up. 
An interface service handles periodic service requests and forwards the requests to 
other programs or processes as appropriate. The Operational Analyst interface 
services include:

� Data manager

� Report data server

� Report Framework

� The respective forwarders and recorders for each historical store.

Interface service name The internal name that Operational Analyst Administration Client uses to identify, 
enable and disable the services. You cannot change the names of the services. 

Interval data See base interval data.

IVR Interactive Voice Response. A technology that allows callers to issue commands to 
a computer without agent intervention. For example, a bank customer can obtain 
account balance information by entering an account number on a touchtone phone.

IVR port Part of an IVR system. An IVR port provides interactive voice response services for 
incoming calls, acting as a virtual agent. Each port uses one phone extension on the 
PBX and can handle one phone call at a time. 

IVR system (IVRS) A server that processes calls using interactive voice response (IVR) technology. An 
IVRS contains a large number of IVR ports. The IVRS is connected to the PBX, 
which routes incoming calls to the IVR ports

Java database 
connectivity

Java Database Connectivity. An application program interface (API) specification for 
connecting Java programs to a database. The API lets you request statements in 
Structured Query Language (SQL) which are then sent to the program that manages 
the database.

JDBC See Java database connectivity.

Job Instruction set that specifies when certain processes should be executed. The 
Scheduled Jobs administration screen enables you to automate certain tasks such 
as data purges and aggregation.

Migration The process by which Operational Analyst alters the database tables to conform to a 
new schema.

MSMQ Microsoft Message Queue. MSMQ is a software program that allows programs to 
send messages to other programs.
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Navigation tree Tree that appears on the left side of your Operational Analyst Administration Client 
interface, and contains various configuration tools for customizing and managing 
data collection.

No data Data collection status that indicates no data exists. Operational Analyst did not find 
matching records. 

Not null Clause in a column or field that specifies that the column or field cannot contain a 
null value. You must define a default value.

Null Special value in the database which represents an unknown value. A null value is 
not the same as blank (which is a valid character), zero (which is a valid number), or 
a zero length string.

On-demand job A job you define to execute tasks on specific data at a particular time or recurrence. 
An on-demand job is different from a system scheduled job in that it is limited in 
scope and applies to selected data. On-demand job types include:

� Aggregation

� Container purge

� Detail purge

� Data collection

� External

ORB Object Request Broker. ORB is the programming code in CORBA that mediates 
between a client and a distributed object. It enables clients to request services 
without having to know the location of the server in a network.

Parameter A piece of information, such as a file name, a coordinate, or a range of values, that is 
passed to a program by a user or another program.

Pending schema A custom-defined schema that is not implemented until migration.

PID See Process ID.

Precision Specifies the maximum total number of decimal digits that can be stored, both to the 
left and to the right of the decimal point. The precision must be a value from 1 to 15.

Process ID Identification number for a container delete job. You can determine the PID of a 
deleted container by looking at the Container Status screen.

Purge The deletion of selected container data or detail data.
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Purge job A job that deletes selected containers and detail data from the historical database. A 
purge job is different from a system-scheduled purge job in that it is more focused 
and deletes only particular pieces of data you specify in the Scheduled Jobs 
administration screen.

Real-time subsystem Along with the source subsystem, historical subsystem, reporting subsystem, and 
CMS subsystem, the real-time subsystem constitutes the Operational Analyst data 
collection system. The real-time subsystem pertains to all Operational Analyst 
components and services that involve real-time data.

Recorder An interface service that resides in the historical subsystem. The recorder time 
stamps the data it receives from the forwarder and inserts the data into the historical 
database.

There are up to 11 recorders, one for each historical store. 

Recurrence The start date and end date of a job, or the number of times a job should be 
executed. For example, you can schedule a job to execute on April 3, 2002 or once a 
week. Recurrence is part of the job definition.

Report Framework The self-contained Operational Analyst reporting framework application 
programming interface (API) that provides an environment to create reports based 
on the Operational Analyst real-time data. It is a framework that lets you develop 
servlet-based applications for Web-based reporting and monitoring for your contact 
center.

Retention period The length of time Operational Analyst retains data.

Rule See container rule.

Scale Specifies the maximum number of decimal digits that can be stored to the right of the 
decimal point. Scale must be a value from 0 through precision. Maximum storage 
sizes vary, based on the precision.

Schema Defines aspects of the database, such as attributes (fields) and domains and 
parameters of the attributes.

Select To select an item, click the item's name or icon. Selected items appear highlighted 
on the screen.

Service See interface service.

Service class A logical category used to measure service levels and define goals for that work. A 
particular service class can consist of any combination of interaction source (such as 
call, fax, or email), customer class (such as Platinum, Gold, or Silver), or activity 
(such as new loan or account inquiry). 
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Shortcut menu

Source subsystem Operational Analyst subsystem that collects all ACD and IC event data.

SQL See Structured Query Language.

Status window Window on the results screen that lets you view the status of elements such as your 
schemas or interface services that you have set up.

Store See historical store.

String A data type contained in the column of the table which is composed of a sequence of 
characters usually representing human-readable text. The column must be a 
contiguous set of alphanumeric characters that does not contain numbers used for 
calculations. Names, addresses and error messages are examples of strings.

Structured Query 
Language

Structured Query Language. The standard programming language for getting 
information from and updating a database. Queries let you select, insert, update, find 
out the location of data, etc.

Subsystem A major component that constitutes the Operational Analyst data collection system. 
The available subsystems are:

� Historical 

� Real-time

� Reporting Framework

� CMS

� Source (ACD and IC)

To Press

Cancel multiple selection of 
items in the status window

Shift + up (or down) arrow key

Copy Ctrl + C

Cut Ctrl + X

Move to the next item on the 
screen

Tab

Move to the previous item on the 
screen

Shift + Tab

Paste Ctrl + V
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Successful Data collection status that indicates data was successfully archived or aggregated.

Summary data Data that pertains to the performance of the contact center. While detail data tracks 
work items, summary data tracks agents and IVR systems. Summary data is also 
aggregated and, if configured, stored in containers and archives.

These historical stores contain summary data:

� Agent service class

� Agent state

� Service class summary

� Service class state

� CMS agent summary

� CMS call work codes

� CMS skill summary

� CMS VDN summary

Summary historical 
store

A historical store that contains aggregated data. Available summary historical stores 
are:

� Agent service class

� Agent state

� Service class summary

� Service class state

� CMS agent summary

� CMS call work codes

� CMS skill summary

� CMS VDN summary

System scheduled 
aggregation job

A job that aggregates base interval data. This job executes on every base interval, 
that is, in 30-minute increments, if enabled.

System scheduled job A job that is executed on a system-wide level. This job applies to all the containers 
and data in the system. The following types of jobs are system scheduled jobs: 
aggregation, aggregation recovery, ACD display name collection, database check 
and database purge.

See also on-demand jobs.
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System scheduled purge 
job

A job that deletes container and detail data from the historical database according to 
the data retention limits defined in the Retention Periods administration screen. A 
system-scheduled purge job is different from on-demand purge jobs in that it 
executes on the entire system and not just on a particular set of data, and it runs 
regularly, not periodically. This executes daily, if enabled.

Tree A way of structuring information, where sublevels are shown as branches of a higher 
level. The navigation tree in Operational Analyst Administration Client contains a 
tree of configuration tools. Items on a tree are also referred to as nodes.

Unicode A character set that can accommodate the alphabet of most of the world's 
languages. Unicode can handle 65,536 character combinations rather than just 256, 
and uses two bytes for each character rather than one.

UTC Coordinated Universal Time. Formerly called Greenwich Mean Time (GMT). UTC 
reflects the time in the prime meridian and uses a 24-hour format. For example, it 
uses 14:00 to represent 2:00 p.m.

Operational Analyst stores data in UTC but converts the time to the local time of the 
client.

Widget A graphical user interface element that lets you interact with the application. 
Examples of widgets include drop-down lists, buttons, text boxes, and radio buttons.

Work item Data that describes the flow of work through a business process. This data may 
include details about the agents involved with the work, the amount of time the item 
spent in various queues, and any followup calls.

Workflow The flow of work in a business process; work travels from one point to another so 
that necessary tasks can be completed on that piece of work.
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